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LOOK HERE: Don’t miss the 
helpful tips and cross-
references given in this 
column.
Welcome

Congratulations on the purchase of your Treo™ 600 smartphone by 
palmOne. In one compact and indispensable device, you now have all 
of the following:
• an advanced mobile phone*
• a Palm Powered™ organizer with portable expansion capability 

(SD media)
• a digital camera
• email*
• web browsing*
• SMS*

This guide will help you set up your Treo and quickly learn to use it. 

*Requires a service contract with your wireless service provider
Welcome   ::   5



If you read nothing else...
This guide is designed to help you start using your 
Treo 600 smartphone quickly, beginning with just 
the basics. As you become more comfortable with 
your Treo smartphone and want to learn more, 
come back and read the other sections.

Read This Now: Getting Started
Follow these instructions to set up your Treo 

smartphone and make your first call. 

First Day: Learning the Basics
Read these pages to learn how to enter text, move 

around the screen, and set up synchronization.

First Week: 
Using Phone, Web, and Messaging 
Learn how to use all the great wireless features of 

your Treo smartphone, including phone, email, web 

browsing, and messaging.

First Two Weeks: 
Using Organizer Features
Your Treo is not just a phone. It also includes a full-

featured Palm Powered organizer that gives you 

instant access to your Calendar, To Do List, Memo 

Pad, CityTime, Calculator, and more. 

First Month: Managing Applications
Learn how to add or delete extra applications and 

use an expansion card with your Treo.

When You’re Ready: 
Customizing Your Treo
Once you’ve learned the basics, you’ll want to 

explore additional features on your Treo 

smartphone and customize its settings.

If Something Happens: Help
If something goes wrong or you can’t figure out 

how to use a Treo feature, we can help. See these 

pages for answers to frequently asked questions.
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8   ::   What you’ll need
What you’ll need

As you work through the instructions in this guide, you’ll need all the items that came 
in the Treo™ 600 smartphone box (see page 9) as well as the following:

• an activated wireless account with data services*
• a location with wireless coverage for your phone 
• an electrical outlet
• the computer that you’ll use to synchronize your personal data
• the CD included in the box

* You cannot use email or web browsing without data services.



You can purchase a 
separate serial HotSync 
cable and other 
accessories. For more 
information, visit 
www.palmOne.com.

Warranty does not cover 
damage by Secure Digital 
(SD™) cards that do not 
meet SD Memory Card 
Specifications. SD cards 
that do not meet SD 
Memory Card 
Specifications may damage 
your Treo 600.
Treo overview

You should have received all of the following components in the Treo 600 smartphone 
box:

Hardware
• Treo handset
• protective case
• AC charger
• USB HotSync® cable
• headset

Documentation and software
• Using Your Treo (this electronic guide)
• Synchronization software CD

Treo handset features
The following illustrations show the locations and names of the physical features of 
the Treo 600 smartphone. Refer to these illustrations while following the instructions 
in this guide.
Treo overview   ::   9
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10   ::   Treo overview
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A. Antenna
B. Wireless Mode button
C. Infrared (IR) port

D. Ringer switch
E. Stylus
F. Expansion card slot



Be careful not to scratch or 
crush your Treo’s 
touchscreen. Use the pouch 
provided with your Treo. Do 
not store it in a place 
where other items might 
damage it.
     

A. Phone receiver
B. LED (Wireless Mode and 

charge indicator)
C. Volume buttons
D. Phone
E. Calendar
F. Headset jack
G. HotSync and power supply connector
H. Microphone
I. SMS
J. Screen on/off button
K. 5-way navigation control
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12   ::   Treo overview

IMPORTANT: The Treo 600 
speaker includes a large 
magnet, so be sure not to 
store your Treo near credit 
cards or other items that 
could be demagnetized.
A Camera lens
B. Speaker
C. Reset button
D. Reset tool (within stylus)

A

C

B

D



Battery consumption varies 
based on your personal 
usage. Consumption 
factors include signal 
strength, backlight and 
speakerphone usage, and 
whether calls are data or 
voice calls.
Charging the battery

Before using your Treo, you need to fully charge the battery. Your phone may not turn 
on at all when you first remove it from the box. We recommend that you charge your 
phone for three hours or until the LED is solid green. 
1. Plug the AC charger into a wall outlet.
2. Connect the charger cable to the bottom of the Treo, with the word UP facing the 

same direction as your Treo screen.

3. To confirm that your Treo is charging, check the LED. 
• When the LED is solid red, your Treo is charging.
• When the LED turns solid green, your Treo is fully charged. 
• If the LED does not light up when you connect your Treo to the charger, double-

check the cable connection and the electrical outlet to which it is connected.

A

A. LED
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14   ::   Charging the ba
 After you turn on your Treo, the onscreen battery gauge displays the power status:

• Full battery icon : Battery is charged

• Partial battery icon : Battery has some power and is not charging

• Empty battery icon : Battery needs charging immediately

• Red lightning bolt : Battery is charging

• Green lightning bolt with full battery icon : Battery is fully charged
ttery



Treo includes a keyboard 
backlight for nighttime use. 
The keyboard backlight 
activates automatically 
when the screen turns on, 
but shuts off if the 
keyboard is not in use. 
When the screen is on, 
press Option, and then P to 
manually activate the 
keyboard backlight. 
Turning Treo on and off

You can use the Palm OS® features of your Treo 600 smartphone independently of 
the wireless features and applications. Therefore, the screen and Wireless Mode are 
designed to be turned off and on separately.

Turning the screen on and off

1. Press the Screen button  to turn on the screen. 

2. Briefly press the Screen button  to turn off the screen.

Turning Wireless Mode on and off
Wireless Mode allows your Treo to connect to your wireless service provider’s network 
so that you can make and receive phone calls and use other wireless services. 

1. Press and hold the Wireless Mode button  to turn on Wireless Mode. You will 
hear a series of ascending tones. When Wireless Mode is on, your Treo connects to 
a wireless network, and you can use the phone and Internet features (if supported 
by the local network).

2. Press and hold the Wireless Mode button  again to turn off Wireless Mode. You 
will hear a series of descending tones. When Wireless Mode is off, your Treo is not 
connected to your wireless service provider’s network. You can still use the 
organizer and other Palm OS features. This is ideal for airplane flights and for 
maximizing battery life.
Turning Treo on and off   ::   15



16   ::   Making your firs

If No Service appears in the 
upper left, you are out of a 
wireless coverage area. If 
you believe you are in a 
wireless coverage area and 
this problem persists, 
contact your wireless 
service provider for 
assistance.

You can adjust the contrast 
or how the screen responds 
to the stylus, at any time. 
(see page 121).

Learn how to quickly redial 
your most recent calls on 
page 42.
Making your first call

We recommend that you charge your Treo for a full three hours (or until the LED is 
solid green) before using it for the first time. 

1. Press Phone .
2. If a Setup screen appears, follow the instructions to select a language and 

calibrate the screen. If a Setup screen doesn't appear, you're ready to continue; 
press Center to unlock the keyguard feature.

3. Press and hold the Wireless Mode button . You will hear a series of ascending 
tones.

4. Allow the Treo to complete a network search. The search may take several 
seconds. When it’s done, the network status icon  appears in the upper right.

5. Tap the onscreen Dial Pad or use the number pad on the Treo keyboard to type the 
desired phone number.

6. Press Center to dial.
7. When your call is complete, use the 5-way navigation control to choose Hang Up 

All.
 

t call



If your phone number 
doesn’t appear in Phone 
Info, consult your wireless 
service provider.
Adjusting call volume
While a call is in progress, press the volume buttons on the side of your Treo to adjust 
the call volume.

What’s my number?
1. Make sure Wireless Mode is on (see page 15). 

2. Press Phone .

3. Press Menu .
4. From the Options menu, choose Phone Info (/I).

A. Volume buttons

A

A. Look here for your phone number

A
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first day: 

learning the 
basics
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20   ::   Moving around 

Some third-party 
applications may not work 
with the 5-way navigation 
control, and you must use 
the stylus instead.

In this guide, we use arrow 
icons to indicate directions 
on your Treo’s 5-way 
navigation control. These 
are different from any 
onscreen arrows that you 
tap with your stylus or 
select with the 5-way 
navigation control to 
display pick lists. 

5-way buttons:

On screen arrows:
Moving around the Treo™ screen

To move around the Treo™ 600 smartphone screen, you can use the 5-way navigation 
control, or tap items on the screen with the stylus. Once you’ve used your Treo for a 
while, you’ll find your own favorite way to scroll, highlight, and select menu commands.
The 5-way navigation control includes Right, Left, Up, Down, and Center buttons.

Scrolling through screens
In the same way that you scroll on a computer, you scroll on the Treo to move from 
field to field, or page to page, or in some cases to highlight an item or option in a list. 
You can scroll in any of several ways:

• Press the 5-way navigation control on the front of the Treo. Pressing Right , 

Left , Up , and Down  moves to the next field, button, or action in that 
direction.

• Press Option  and Up  or Down  to scroll to the next page of information 
within the current record. 
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Once you’ve launched an 
application (see page 27), 
you can experiment with 
using the 5-way navigation 
control to highlight different 
screen elements.
• When inside a text field, press Up  and Down  to scroll through the text.
• Tap an onscreen scroll arrow.

• Drag the slider of an onscreen scroll bar.

Highlighting items
The 5-way navigation control lets you highlight items before launching or selecting 
them. 
• When an onscreen button (OK, Cancel, etc.) or pick list is highlighted, a blue glow 

appears around the border.

• When a phone number, email address, or web link is highlighted on a web page or 
in a message, the text appears in reverse type (light text on a dark background).

• When an entire text entry field is highlighted, you can press Center to edit the text. 
After you edit the text, press Center again to highlight the entire field.

You can also use the stylus to highlight text on the screen. Highlighted text appears in 
reverse type.
• Drag the stylus across the text you want to highlight.
• Double-tap a word to highlight it.
• Triple-tap a line of text to highlight it.
Moving around the Treo™ screen   ::   21



22   ::   Moving around 

Most menu commands 
have keyboard shortcuts 
listed in the menu. To use a 
shortcut, press Menu plus 
the shortcut letter. You 
don’t have to see the menu 
item to use the shortcut.
Accessing command buttons
Command buttons, such as New, OK, and Details appear at the bottom of the screen. 
In many cases you can jump directly to these buttons instead of scrolling to them.

• From a list screen, such as the Contacts list or Mail inbox, press Right  to jump to 
the first button.

• From a screen where you create or edit entries, such as Edit Contacts or Day View 
in Calendar, press Center to jump to the first button.

• From a dialog, such as Edit Categories, press Right  to scroll to the first button, or 
press Option , and then Return  for OK, or Option  and then Backspace 

 for Cancel.

Choosing or activating items
After highlighting an item with the 5-way navigation control, you can choose or 
activate it by pressing Center. You can also choose an item by tapping it with the 
stylus.

Selecting menu items
Many applications have menus to provide access to additional features. These menus 
are usually hidden from view, but they appear when you press Menu . To get the 
most out of your Treo, it’s a good idea to familiarize yourself with the additional 
features available through the various application menus.

1. Press Menu  to display an application’s menus.

2. Press Right  and Left  to switch between menus.
the Treo™ screen



To exit the pick list and 
cancel your selection, press 
Left  or Right , or tap 
outside the pick list.
3. Press Up  and Down  to highlight a menu item.

4. Press Center to choose the menu item, or press Menu  to close the menu and 
cancel your selection.

Choosing options in a pick list
A range of options is often presented in a type of menu called a pick list, which can be 
identified by a downward-pointing arrow. Pick lists are different from the application 
menus described above.

To choose from a pick list, do one of the following:
• Use the 5-way navigation control to highlight the pick list, and then press Center to 

display the items in the list. Press Up  and Down  to highlight the item you 
want, and then press Center to accept your selection.

• Use your stylus to tap the pick list, and then tap the item you want from the list.
Moving around the Treo™ screen   ::   23



24   ::   Using the keybo

When using the keyboard, 
most people find it easiest 
to hold the Treo with two 
hands and use the tips of 
both thumbs to press the 
keys, as shown above. 
Using the keyboard

Using the keyboard backlight

• To turn on the backlight, press Option , and then . The backlight may not be 
visible in bright sunlight. 

• The backlight turns off if the keyboard is not in use.

A. Option
B. Shift/Find
C. Alt
D. Space
E. Applications Launcher
F. Menu
G. Return
H. Backspace
ard



In many applications you 
can view a list of all the 
alternate characters. From 
the Edit menu, choose 
Keyboard Help (/G). 

Some application views, for 
example, Dial Pad and 
Calculator, automatically 
default to Option Lock, so 
you don’t have to hold 
down Option to enter 
numbers.

The alternate characters 
are grouped according to 
their similarity to the 
corresponding key. For 
example, the alternate 
characters available for the 
e key are é, è, ë, ê and 
Entering lowercase and uppercase letters
• To type lowercase letters, press the desired keys. 

• To type an uppercase letter, press Shift , and then type a letter. You don’t need 
to hold down Shift while typing a letter.

• To turn Caps Lock on, press Shift  twice. To turn it off, press 

Shift  again. When Caps Lock is on, this symbol appears in the lower right: 

Entering numbers, punctuation, and symbols that appear above the 
letters on the keys 
• Press Option , and then press the key with the desired character shown above 

the letter. You don’t need to hold down Option while pressing the second key.
• To turn Option Lock on, press Option  twice. To turn it off, press 

Option  again. When Option Lock is on, this symbol appears in the lower right: 

Entering other symbols and accented characters
1. Type the character that corresponds to the symbol or accented character you want. 

See the table on the next page.

2. Press Alt .

3. Press Up  or Down  to highlight the desired character.
4. Press Center to insert the character, or just continue typing the next character.
Using the keyboard   ::   25



Symbols and accented characters
Type... then press Alt to 

choose...
Type... then press Alt to 

choose...
Type... then press Alt to 

choose...

a á à ä â ã å æ o ó ò ö ô œ õ ø 0 % ‰ °
A Á À Ä Â Ã Å Æ O Ó Ò Ö Ô Œ 1

b or B ß p or P % 2

c ç ¢ © ^ ˆ r or R ® 3

C Ç ¢ © ^ ˆ s ß Šs § . ? ! …

d † ‡ S ß ŠS § , „

D † ‡ – D t or T ~ ™ † ‡ ! ¡
e é è ë ê u ú ù ü û ? ¿

E É È Ë Ê U Ú Ù Ü Û : ; :-) :-( ;-) :-D

f or F ƒ x or X x ' ‘ ’ < > ~ `
i í ì ï î y  ÿ ¥ " “ ” « »
I Í Ì Ï Î Y  Ÿ ¥ $  £ ¥ ¢
l or L £ + &
m or M µ - _ ~ • = – —
n ñ / % \ ÷ | 
N Ñ # =

( < [ { ‹
) > ] } ›
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You can also customize the 
buttons yourself; see 
page 124 for details.

Your wireless service 
provider may have 
customized the applications 
associated with each 
button.
Launching applications

You can use the application buttons on the front panel to launch two applications. To 
access a button’s primary application, simply press the button. To access a button’s 
secondary application, press Option , and then press the application button. The 
fourth button turns the screen on and off and controls the keyguard. 
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28   ::   Launching appl

Press Applications 
Launcher repeatedly to 
cycle through different 
categories of applications.

In the Applications 
Launcher, you can type the 
first few letters of the 
application’s name to 
highlight it. For example, if 
you type ci it highlights 
CityTime. However, if you 
pause between typing 
letters, it highlights Calc, 
and then the first 
application that starts with i.   
Button Primary application Secondary application

 Phone  +  Blazer® web browser

 Calendar  +  CityTime 

 SMS  +  Mail 

 Screen (on/off)  +  Keyguard 

In Palm OS®, you access all available applications through a screen called the 
Applications Launcher:

1. Press Applications Launcher .
2. Use the 5-way navigation control to highlight the application you want to use.
3. Press Center to launch the selected application.
ications



IMPORTANT: If you’re 
upgrading from another 
Palm Powered device, 
follow the upgrade steps on 
page 136 before you set 
up your computer for your 
new Treo.

If you are synchronizing 
with a computer that is 
running Windows NT 4, you 
must use a serial HotSync 
cable, available for separate 
purchase at 
www.palmOne.com.
Setting up your computer

Synchronization lets you enter information on your computer (using Palm® Desktop or 
Microsoft Outlook for Windows) and then efficiently transfer that information to your 
Treo. At the same time, changes you make on your Treo are transferred to Palm Desktop 
or Microsoft Outlook. Even if you manage all your contacts on your Treo, synchronization 
is a great way to back up your data.

Before you can synchronize, you need to install Palm Desktop software on your 
computer. Even if you already own a Palm Powered™ device and have installed a 
previous version, you must install the software that comes with your Treo.

System requirements

Windows 98SE, Me, 2000, or XP*
• 32 MB of memory
• 30 MB of free hard disk space
• CD-ROM drive
• available USB port and USB HotSync® cable (cable included with your Treo)

Windows NT 4
• 32 MB of memory
• 30 MB of free hard disk space
• CD-ROM drive
• available serial port and serial HotSync cable (cable sold separately)

Macintosh OS 10.1-10.3.x*
• 32 MB of memory
• 25 MB of free hard disk space
• CD-ROM drive
• USB port and USB HotSync cable (cable included with your Treo)
*later versions may also be supported
Setting up your computer   ::   29
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30   ::   Setting up your 

For best performance, plug 
your USB synchronization 
cable directly into a USB 
port on your computer. If 
you use a USB hub, make 
sure it is a powered hub.
Connecting your Treo to your computer
1. Plug the AC charger into a wall outlet. If necessary, connect an adapter.
2. Connect the charger to the short end of the HotSync cable. Be sure to match the 

sides of the connectors labeled UP.
3. Plug the USB HotSync cable into an available USB port on your computer.
4. Connect the long end of the HotSync cable to the bottom of your Treo with the 

button facing up.

A. USB cable
B. HotSync button

A

B

computer



If you are installing on a 
computer at work, make 
sure your company allows 
you to install new software. 
Contact your company’s IT 
department for help.
Installing Palm Desktop software on your computer
Your computer needs all of its resources available to install the desktop 
synchronization software. Follow these guidelines for a successful installation:
1. Exit any applications that are currently running on your computer, including those 

running in the background.
2. Insert the CD that came with your Treo into the CD-ROM drive on your computer. If 

you are installing on a Macintosh, double-click the CD icon on the desktop, and 
then double-click the Installer icon.

3. Follow the onscreen instructions of the installation program. Click Install Now to 
install Palm Desktop software. Please note these important points about the 
installation process:
• If a language selection screen appears, choose the same language you use on 

your Treo. 
• During the installation process, you will be prompted to synchronize for the first 

time. 
Setting up your computer   ::   31



32   ::   Synchronizing y

We strongly recommend 
that you install 
Palm Desktop software 
soon after you start using 
your Treo, and that you 
synchronize your Treo and 
computer frequently to 
keep your information up-
to-date (and backed up) in 
both locations.
Synchronizing your contacts and 
other data

Before you can synchronize your contacts and other personal data, you must install 
Palm Desktop software from the CD that came with your Treo. See page 31 for 
instructions.

1. Connect your Treo to your computer as described on page 30.
2. Press the HotSync button on the cable.

3. Wait for your Treo to display a message indicating that the process is complete.
• If nothing happens, make sure that you installed Palm Desktop software and 

that the HotSync Manager application is running on your computer ( ).
• If you want to synchronize data with applications other than Palm Desktop or 

Microsoft Outlook, you need to purchase additional third-party conduit software. 
• If you have any problems performing a HotSync operation, see page 145 for 

troubleshooting suggestions.

A. HotSync button
A

our contacts and other data



We recommend that you 
charge your Treo for a full 
three hours, or until the 
LED turns solid green,   
before using it for the first 
time.

If the battery is fully 
drained, and your Treo 
doesn’t turn on, the Treo 
stores your data safely for 
about three days. We 
recommend that you 
charge and synchronize 
your Treo every day, 
especially if you use your 
phone often.

If the battery is fully 
drained, it may take a few 
moments for the LED to 
light up while charging.
Battery life

Battery life depends on individual usage. When used as a phone, your Treo battery 
provides up to 4 hours of talk time or up to 10 days of standby time on the 1900 MHz 
band. Talk time is slightly lower when operating on the cellular 800 MHz band. When 
used as an organizer only (no phone), the battery provides up to 4 weeks of normal 
use.

Maximizing battery life
You can increase the life of your Treo battery by following a few easy guidelines. 
Remember that battery life depends on how you use your Treo.
• Charge your Treo whenever you’re at your desk. The Li-Ion battery in your Treo has 

a much longer useful life when it is topped off frequently, versus charging it after it 
is fully drained.

• The wireless features (phone, email, messaging, and web) of your Treo generally 
consume more power than its organizer features. However, if you spend a lot of 
time using the camera, games, media players, eBooks, or other Palm OS 
applications, keep an eye on the battery level and charge when necessary.

• If you don’t plan to use the wireless features on your Treo for a while, you may want 
to turn off Wireless Mode (see page 15). You can forward calls to a different 
number (see page 49) or let all calls be picked up by voicemail (see page 43) if 
your service plan includes call forwarding or voicemail features.
Battery life   ::   33



34   ::   Battery life
• As with any mobile phone, if you are in an area with no wireless coverage, your 
Treo continuously searches for a signal, which consumes power. If you cannot 
move to an area of better coverage, temporarily turn off Wireless Mode to conserve 
battery power. 

• Use the keyboard backlight (see page 24) only when you need it. 
• Turn down the screen brightness (see page 121).
• Decrease the Auto-off setting in General Preferences (see page 128). This turns 

off your screen automatically after a shorter period of inactivity.



To launch the built-in 
tutorial:
1. Press Applications 

Launcher. 
2. Choose the pick list in 

the upper-right, select All.
3. Choose the Tutorial icon.
4. Follow the onscreen 

instructions in the 
Tutorial.
Where to learn more

A quick introduction to your new Treo
• Tutorial: The Tutorial teaches you how to use many features of your Treo. It is 

already installed on your Treo, and you can launch it any time.

While using your Treo
• Tips: Many of the built-in applications include helpful tips for getting the most out 

of your Treo. To view these tips, launch an application, press Menu , and then 
from the Options menu, choose Tips.

• Information: Many screens have an Information icon  in the upper-right corner. 
Tap the Information icon with your stylus to learn about the tasks you can perform 
on that screen.

• Online support from palmOne: For up-to-date downloads, troubleshooting and 
support information, check out www.palmOne.com/support/treo600.

If you need more information
• Books: Many books on Palm Powered devices are available in local or online book 

retailers (look in the computers section).
• Online forums: Consult online Treo user discussion groups to swap information 

and learn about areas you may find nowhere else.
• Customer service from your wireless service provider: For questions about your 

wireless account or features available on the network, contact your wireless 
service provider for the latest information and help.
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36   ::   Where to learn 
more



first week: 

using phone, 
web, and 
messaging
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38   ::   Phone overview
Phone overview

The Phone application lets you make and receive calls, store information about your 
contacts, and store Favorites for contacting people and launching applications. Be 
sure you know how to turn on Wireless Mode before reading this section (see 
page 15).

Accessing the Phone application

• Press Phone .



To display the remaining 
battery power, tap the 
battery icon at the top of 
the screen.

If TTY/TDD Mode is active, 
you won’t see the call 
forwarding icon.
The icons at the top of the Phone screen let you monitor the status of these items:

Network 
name

Displays your wireless service provider’s name when Wireless Mode is on 
and you are in your wireless service provider’s coverage area. If you are 
outside your wireless service provider’s coverage area, No Service or 
Roaming appears instead. No Service means that there is no coverage at 
all, and Roaming means that another wireless service provider’s network 
is available. When you turn off Wireless Mode, it displays Wireless Mode 
is Off.

Appears when call forwarding is active.

Appears when TTY/TDD Mode is active.

Appears when you have new voicemail messages. You can tap this icon 
to retrieve your messages. (Not supported by all wireless networks.)

Appears when you are outside your wireless service provider’s coverage 
area and you are roaming on another wireless service provider’s network. 
This icon may blink if the provider is not on your wireless service pro-
vider’s preferred roaming list.

Appears when Wireless Mode is on. The bars display the signal strength. 
The stronger the signal, the more bars appear. If you are outside a cover-
age area, both the tower and bars disappear.

Appears with green arrows when you are connected to a data network 
and transferring data. You cannot receive calls. Appears with gray arrows 
when you are standing by to send or receive data. You can still receive 
calls.

Displays the battery charge status. When the battery drains to 25% of its 
capacity, the icon changes from blue to red. When the battery drains to 
5% of its capacity, the icon changes from red to clear

Appears when your Treo™ 600 smartphone battery is charging.

Appears when your Treo battery is fully charged.
Phone overview   ::   39



40   ::   Dialing calls

For more information 
(address, company, etc.) 
about a person in your 
Contacts list, highlight the 
name and press Center.

You can begin a Name 
Lookup immediately from 
the Main view in the Phone 
application. From the 
Options menu, select 
Display Preferences. 
Choose the second pick list 
and select Typing starts 
Contacts search.
Dialing calls

Your Treo offers several options for making phone calls. As you become more familiar 
with your Treo, you’ll discover which method you prefer.

Dialing with the keyboard

1. Press Phone .
2. Using the numbered keys on the keyboard, type a phone number. You do not need 

to press Option to access the numbers on the keyboard.
3. Press Center to dial.

Dialing by contact name
Before you can dial a call by contact name, you must create contacts (see page 50) 
or import them with a HotSync® operation (see page 32). 

1. Press Phone .
2. Use the 5-way navigation control to access the Contacts list.
3. Using the keyboard, begin typing one of the following for the contact you want to call:

• First initial and last name
• First name
• Last name

4. Choose the number you want to dial.
5. Press Center to dial.

To start another search, press Backspace to delete letters you’ve entered. Or, just 
press Phone  to start all over.



You can paste numbers 
directly into the Dial Pad 
view. Copy a number from 
another application, and 
then switch to Dial Pad 
view. Press Menu, and then 
from the Edit menu, choose 
Paste. Press Center to dial.
Dialing with a Favorites button 

Before you can use Favorites buttons, you must create some Favorites entries. See 
page 52.

1. Press Phone .
2. Use the 5-way navigation control to access your Favorites buttons.
3. Highlight the desired button.
4. Press Center to dial the selected button.

Dialing with the onscreen Dial Pad

1. Press Phone .
2. Tap the onscreen Dial Pad to enter the number.
3. Press Center to dial.
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If you can’t highlight and 
dial a phone number on a 
web page or in a text 
message using the 5-way 
navigation control or stylus, 
it means that Treo does not 
recognize it as a phone 
number.
Dialing from a web page or text message
Treo recognizes most phone numbers that appear in web pages or text messages.
1. Use the 5-way navigation control to highlight the phone number you want to dial.
2. Press Center to dial.

Redialing the last number you called
Do any of the following to redial the last number you called:

• Press Phone . Then press Center to see a list of your recently dialed numbers.

• Press Phone , and then press Center. Choose Dial Pad, and then choose Dial to 
display the last number you dialed.

• Press Phone , and then press Center. Choose Call Log. This view shows all your 
recent calls in chronological order. Press Center to dial the last number you called. 



Voicemail services must be 
active on your account 
before sending a call to 
voicemail. Otherwise you 
can check the Call Log to 
see a missed call (if the 
caller’s number was not 
blocked).

To prevent calls from 
accidentally being 
answered while the phone 
is in a pocket or briefcase, 
you can disable the 
touchscreen when an 
incoming call arrives (see 
page 130).

See a photo of the person 
calling you! Learn how to 
assign a caller ID picture 
on page 118.
Receiving calls

To receive calls, Wireless Mode must be on. This is different from having just the 
screen turned on (see page 15).

To answer a call, do one of the following:
• Using the 5-way navigation control, choose the onscreen Answer button.
• If the headset is attached, press the headset button.

To ignore a call and send it to voicemail, do one of the following:

• Press Backspace .
• Using the 5-way navigation control, choose the onscreen Ignore button.

To silence the ringer while your phone is ringing:
• Press the volume buttons or any key on your Treo except the 5-way navigation 

control, Space, Return, or Backspace.
• To immediately silence all system sounds including the ringer, slide the ringer 

switch to Sound Mode Off .
When you silence the ringer, you can either answer the call or let it ring through to 
voicemail. 

If audio (MP3 music, for example) is playing, and a call arrives, you can still hear the 
phone ringing softly. To answer the call, do one of the following:
• Using the 5-way navigation control, choose the onscreen Answer button.
• Press the headset button (if headset is attached).
The audio continues playing but you won’t hear it during your call. 
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Using voicemail

Setting up voicemail 
If you subscribe to voicemail services, you can customize your personal options.
1. Turn on Wireless Mode, as described on page 15.
2. Press Phone .
3. Use the 5-way navigation control to access Favorites.
4. Choose the Voicemail Favorites button.
5. When you hear your outgoing message, press # to access the system prompts.
6. Follow the system prompts to customize your personal options.

Your Treo connects to your wireless service provider’s automated voicemail system. If 
your Treo is unable to connect to the automated system, please contact your wireless 
service provider for assistance.



If a voicemail icon appears 
in the title bar at the top of 
the screen, you can tap this 
icon to retrieve your 
voicemail.
Voicemail notification
When you have new voicemail, you are notified with an alert that indicates the number 
of messages you have waiting. A voicemail icon  may also appear near the top of 
your screen (this feature is not supported by all wireless networks).

Retrieving voicemail messages
If the Voicemail alert is on your screen, you can choose that button to hear your 
message(s). If you’ve already dismissed the alert, follow these steps to retrieve your 
messages:

1. Press Phone .
2. From the Phone application Main view, Dial Pad, or Favorites, press and hold 1 on 

the keyboard. Treo dials your wireless service provider’s voicemail system.
3. When you hear your outgoing message, press # to access the system prompts.
4. Enter your voicemail password using the Treo keyboard, or choose Extra Digits if 

you defined this option (see page 54 for information on editing Favorites buttons). 
Remember, you do not need to press Option to type numbers, *, or # while on an 
active call.
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Press Phone repeatedly to 
toggle between the Active 
Call screen and the Main 
view of the Phone 
application.

The personal speakerphone 
lets you use other features, 
such as checking your 
calendar, during a call.

The Extra Digits button 
appears only during 
outbound calls that you 
dialed with a Favorites 
button to numbers that 
include pre-defined extra 
digits (see page 53). 

To avoid accidentally 
pressing onscreen buttons 
while you’re holding the 
phone up to your ear to 
speak, you can disable the 
touchscreen during active 
calls (see page 130).
Managing active calls

When you make or receive a call, the Active Call view appears. Use the 5-way 
navigation control to access the onscreen buttons in this view:

• Hang Up All (or pressing Backspace ): Ends the call immediately. You can also 
press the headset button (if the headset is attached).

• Spkr-phone (or pressing Space ): Switches to the personal speakerphone. 

• Hold (or pressing Period ): Places the current call on hold. 

• Dial Pad (or pressing Return : Opens the Dial Pad so you can manually dial 
additional numbers.

• Mute: Mutes the Treo microphone so you cannot be heard.
• Add Call: Lets you place another call while the first call is on hold. First choose 

Hold, and then choose Add Call. 
• Extra Digits: Dials any extra digits (such as a password or extension) that you 

assigned to a Favorites button. See page 53 for information on creating a speed 
dial Favorites button.

A. Caller’s name and number
B. Current duration of call
C. Hang up immediately
D. Switch to speakerphone
E. Place current call on hold
F. Mute the microphone
G. Open Dial Pad view

A

B
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You can use nearly any 
other application on Treo 
while on an active call, 
including the organizer 
features and SMS. 
However, you cannot send 
and receive email or 
browse the Internet while 
on an active call. To return 
to an active call from 
another application, press 
Phone.
More ways to manage calls

Treo offers many advanced telephone features, including call waiting, conference 
calling, and call forwarding. 

Making a second call
You can make a second call while your first call is still active.
1. After dialing the first number, use the 5-way navigation control to choose Hold.
2. Use the navigation control to choose Add Call.
3. Dial the second number using Favorites, Contacts, Dial Pad, Call Log, or Redial list 

(see page 40).

The Active Call view now includes two status lines, each representing one of the calls. 
You can join the two calls in a three-way call, but you cannot switch between the two 
calls. To end both calls, choose Hang Up All.
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You cannot initiate a three-
way call if the second call 
is incoming.
Answering a second call (call waiting)
When you are on an active call, you can receive a second call. When the second call 
comes in, the Call Waiting dialog appears, giving you the following options for 
handling the second call:
• To place the current call on hold and answer the new call, use the 5-way navigation 

control to choose Answer.
• To send the new call to voicemail, use the 5-way navigation control to choose Ignore.

Making a three-way call
Talk to two people at the same time with three-way calling. Normal airtime rates apply 
for each of the two calls.
1. Dial the first number.
2. While the first call is active, place a second call. 
3. Use the 5-way navigation control to choose Conf. This joins the two calls in a 

three-way call.
4. Use the navigation control to choose Hang Up All and end all the calls.
anage calls



Forwarding all calls
You can forward all of your calls to another telephone number. Keep in mind that 
additional charges might apply for forwarded calls.

1. Press Phone .

2. Press Menu .
3. From the Options menu, choose Phone Preferences (/A).

4. Choose the Forward all calls to pick list. 
• If the forwarding number appears in the pick list, select the number. 
• If the forwarding number does not appear in the pick list, select Edit Numbers, 

and then choose New. Enter a 10-digit forwarding number without spaces. 
Choose OK twice to finish.

5. Choose OK.
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If you have several 
contacts to enter, it’s more 
efficient to use 
Palm® Desktop software 
or Microsoft Outlook on 
your computer and then 
synchronize data between 
the Treo and your 
computer. For more 
information, see page 32.

In the Contacts view, Up 
and Down move to the 
previous or next Contacts 
record.

Be sure to label your 
contacts’ wireless numbers 
correctly. The SMS 
application (see page 67) 
looks up only numbers 
labeled as Mobile.
Managing contacts

Contacts is a view in the Phone application. If you are familiar with Palm Powered™ 
devices, you may recognize that Contacts is similar to the Address Book application 
on previous devices.

Adding a contact

1. Press Phone .
2. Use the 5-way navigation control to access the Contacts list.
3. Choose New Contact.

4. Use the 5-way navigation control to move between fields as you enter information.
5. To place the entry in a category or mark it private, choose Details.
6. To add a note to an entry, choose Note.
7. After you enter all the information, choose Done. 
cts



Viewing or changing contact information
1. In the Contacts list, begin typing one of the following for the contact you want to 

view or edit:
• First initial and last name
• First name
• Last name

2. Choose the name of the entry you want to open.
3. Press Center to open the entry.
4. Choose Edit.
5. Make changes to the entry as necessary.
6. Choose Done.

Deleting a contact
1. Open the contact you want to delete.
2. Press Menu .
3. From the Record menu, choose Delete Contact (/D).
4. Choose OK. 

Defining your business card
1. Create a new contact with your business card information.
2. While still in Contact Edit view, press Menu .
3. From the Record menu, choose Select Business Card.
4. Now you can beam your business card to other Palm OS® devices. From the Main 

or Contacts view in the Phone application, press Menu . From the Record 
menu, choose Beam Business Card (/M).
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To see the next page of 
Favorites, press Right 
repeatedly. To see the 
previous page, press Left 
repeatedly.
Defining Favorites buttons

Treo provides 50 programmable Favorites buttons for quick access to the following 
common tasks: 
• Dialing a phone number (speed dial)
• Launching an application
• Accessing a web page
• Addressing a text message
• Accessing voicemail (preset on Treo)
Your wireless service provider may include special Favorites buttons on your Treo that 
are customized for their services.

You can assign a Quick Key to a Favorites button. Then from the Main, Favorites, or 
Dial Pad view, you can press and hold the Quick Key to launch the Favorite associated 
with it. Quick Keys are optional, must be letters, and are not case sensitive. 
es buttons



To see all the contact 
numbers for the selected 
person or business, 
highlight the Favorite 
button and press Space.
Creating a speed dial Favorites button

1. Press Phone .
2. Use the 5-way navigation control to access your Favorites buttons. 
3. Choose a blank button.
4. Choose the Type pick list, and then select Speed Dial.
5. Enter a label and phone number for the Favorite by doing one of the following:

• If the entry is for an existing contact, choose Lookup. Start typing the last name 
of the contact, and then select the contact when it appears in the Lookup list.

• If the entry is for a new contact, type the Label, press Down  and type the 
Number.

6. (Optional) Enter a Quick Key. When you are in the Phone application, you can press 
and hold the Quick Key to instantly launch the Favorite.

7. (Optional) Choose More, and select advanced options:
• Extra Digits: Lets you define additional digits to dial, such as a password or 

extension.
• Dial Extra Digits Automatically: Dials predefined Extra Digits two seconds after 

dialing the phone number, when checked. Add commas to insert more pauses.
• Ringtone: Assigns a special ringtone for incoming calls from that contact.
• Image: Assigns a Caller ID picture that displays when that person calls.

8. Choose OK.
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You can also organize your 
Favorite buttons on 
different pages. From the 
Edit menu, choose Edit 
Favorites Pages.

You cannot edit or delete 
the voicemail entry.
Creating an application, message, or web link Favorites button

1. Press Phone .
2. Use the 5-way navigation control to access your Favorites buttons. 
3. Choose a blank button.
4. Choose the Type pick list, and then select Application, Message, or Web Link.
5. Enter a label for the Favorite, and enter any other necessary information on the 

screen.
6. (Optional) Enter a Quick Key that launches the Favorite when pressed and held.
7. Choose OK.

Editing or deleting an existing Favorites button

1. Press Phone .
2. Use the 5-way navigation control to access your Favorites buttons.
3. Highlight the Favorites button you want to edit or delete.
4. Press Menu .
5. From the Edit menu, choose Edit Favorites Button (/E).
6. Make the desired changes. For example, you can add a Quick Key shortcut to any 

Favorite. When you press and hold the assigned letter from within the Phone 
application, the Favorite launches.

7. To delete the entry, choose Delete.
8. Choose OK. 
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In addition to the headset 
that came with your Treo, 
you can use other third-
party headsets. 

To hear stereo through the 
jack (such as music), you 
should use a stereo 
adapter or other accessory. 
Visit www.palmOne.com for 
more information.

The headset designed for 
previous models of Treo is 
not compatible with the 
Treo 600.
Using a phone headset

You can connect a phone headset for hands-free operation. If you need to use your 
phone while driving, and this is permitted in your area, we recommend using a phone 
headset.

• You can press the headset button to perform any of the following tasks:
• answer an incoming call
• answer a call-waiting call
• join two calls in a three-way conference
• hang up all calls

Headset specifications
Your Treo uses a 2.5mm, 3-pin headset connector. Use only headsets with this type of 
connector. When in doubt, ask the third-party headset manufacturer if their product is 
compatible with Treo phones. If the headset buzzes or the microphone doesn’t work 
properly, your headset may be incompatible with Treo.

A. Speaker
B. Microphone
C. Headset button

A

C

B
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If you browse to a secure 
web page, a Lock icon 
appears.

Lots of pretty graphics 
slowing you down? Browse 
the web faster by turning 
off images. From the 
Options menu, choose 
Preferences, and then 
check the Don’t Show 
Images box.

Tap and hold the back or 
forward buttons to pop up 
a list of sites you’ve visited.
Browsing the web

Blazer® web browser provides quick and easy access to web pages right on your 
Treo. You can view the regular sites you use today, including those with security and 
advanced features like JavaScript and frames. To browse the web, you must activate 
data services from your wireless service provider. 

Viewing a web page
1. Make sure Wireless Mode is turned on, as described on page 15.
2. Press Phone . 
3. Use the 5-way navigation control to choose Web.

4. Choose the Page View  icon.
5. Press Space to jump between the Web page contents and the icons at the bottom 

of the screen.
6. Navigate to the web page you want:

• To view a portal of content designed specifically for your Treo, choose .
• To go to any web page on the Internet, choose . 
• To view the previous or next page, choose  or .
• To refresh the page with the latest content available from the Internet, choose .

Navigating in Optimized Mode
Blazer uses a patent-pending technology to optimize web pages for your Treo. By 
default, the browser reformats web pages into one column on your screen. This way, 
you can see most content without scrolling left or right. 
• Press Up  or Down  to move through a web page.

• Press Left  or Right  to move between links on the page. To follow a link to 
another web page, highlight the link, and then press Center. You can also tap the 
link on the screen with your stylus.
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Want to get to the icons 
faster? Press Space to 
jump down to the icons, or 
press Menu to access the 
commands through the 
menus.

Always using bookmarks? 
Make Bookmark View the 
default view when you 
launch the browser. From 
the Options menu, choose 
Preferences, and then 
select the Bookmarks icon 
as your Initial View.
Navigating in Wide Page Mode
Some web pages, such as maps, are easier to view without the optimization done in 
Optimized Mode. You may want to view these pages in Wide Page Mode. This mode 
presents the web page as you would expect to see it on your computer’s screen.
1. Go to the page you want to view. 

2. Press Menu .
3. From the Page menu, choose Wide Page Mode (/W).

• Press Up , Down , Left , or Right  to scroll through the wide page.
• To follow a link to another web page, tap the link with your stylus.

Creating a bookmark
Bookmarks let you instantly access a web page, without typing the address every 
time. Blazer can store up to 100 bookmarks or saved pages, allowing you to open 
your favorite web pages quickly. Remember, a Blazer bookmark is different from a 
Favorite (see page 52).
1. Go to the page you want to bookmark. 

2. Press Menu .
3. From the Page menu, choose Add Bookmark (/A).

4. If desired, change the Name and Description
5. Choose OK.
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To move a bookmark or 
saved page to a different 
slot on the current page, 
use the stylus to drag and 
drop it into another slot. To 
move a bookmark or saved 
page to a different page, 
drag and drop it on the 
corresponding page icon.
Saving a page
Blazer lets you save a page for offline viewing, so you don’t need an Internet 
connection to view it later.
1. Go to the page you want to save.
2. Press Menu .
3. From the Page menu, choose Save Page (/S).
4. Choose OK.

Viewing bookmarks or saved pages
Bookmarks and saved pages both appear in Bookmark view. Saved pages are 
indicated by a small triangle in the upper-right corner of the bookmark.

1. Choose the Bookmarks view icon .
2. Choose the bookmark or saved page you want to view.

Editing or deleting a bookmark or saved page

1. From the Bookmarks view, press Menu .
2. From the Bookmarks menu, choose Edit Bookmarks.
3. Choose the bookmark you want to edit or delete.
4. Enter the desired changes.
5. Choose OK.
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If Blazer does not 
recognize a phone number 
as dialable, you can copy 
the phone number (as text) 
and paste it into the Phone 
Dial Pad (see tip on 
page 41).

To find ringtones and 
software for your Treo, 
choose the Downloads 
bookmark.
Arranging bookmarks and saved pages
Blazer includes 10 pages for arranging bookmarks and saved pages by topic. For 
example, you can store travel links on one page, stock links on another, and business 
links on a third page.

1. From the Bookmarks view, press Menu .
2. From the Bookmarks menu, choose Edit Bookmarks.

3. Type a new title for this page.
4. Use the stylus to drag and drop bookmarks into different slots on the current page. 

To move a bookmark to a different page, drag and drop it on the corresponding 
page icon.

5. Choose OK.

Downloading files from a web page
Blazer lets you download files that are usable on your Treo, such as new applications 
or MIDI ringtones. When you download a file, it is automatically sent to the application 
that can use the file. Note: Only certain images tagged specifically for download can 
be downloaded by Blazer. 
1. Go to the page that contains the link to the file you want to download.

2. Press Left  or Right  to highlight the link to the file, and then press Center to 
initiate the download process.

A. Page icon

A
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Visit secure web sites. The 
128-bit SSL, strong 
encryption lets you browse 
secure sites, such as online 
shopping, banking, and 
email. Remember: some 
secure sites also require 
specific browsers and may 
not work with Blazer.
Navigating web sites with split pages (Frames)
Some web sites split their pages into separate areas, each with their own scroll bars. 
You can navigate these sites more easily by “zooming in” on one of the separate 
areas. To do this:
1. Tap inside the area of the split page you want to make larger. Make sure you tap on 

an area that is not a link, otherwise, you will navigate to that link.

2. Tap the magnifying glass icon in the navigation bar . This will make the area you 
tapped on the entire page. Note: This icon only appears if you are on a page that is 
split into separate areas. 

Copying text from a web page
You can copy text from a web page and paste it in other applications. 
1. Use the stylus to highlight the text you want to copy.

2. Press Menu . 
3. From the Edit menu, choose Copy (/C). 
4. Go to the application in which you want to paste, and then position the cursor 

where you want to paste the text.

5. Press Menu .
6. From the Edit menu, choose Paste (/P).

Using the History list
The History list stores the addresses of the last 100 pages you visited. Items in the 
History list are sorted chronologically.

1. From the Page view, press Menu .
2. From the Page menu, choose History.

3. Press Up  to access the list, and then press Down  to navigate through the list.
4. Choose the web page you want to load.
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Blazer supports JavaScript, 
SSL, and cookies, but does 
not support plug-ins (Flash, 
Shockwave, etc.) or Java 
applets.

Email from a web page. 
Email addresses appear as 
links on web pages. After 
you configure an email 
application on your Treo, 
you can select an email 
address link to create a 
message to the selected 
address.
Finding text on a web page

1. From the Page view, press Menu .
2. From the Page menu, choose Find Text on Page.
3. Type the text you want to find.
4. Check or uncheck the Wrap Search box to indicate whether you want the search to 

wrap from the end of the page to the beginning when the end is reached.
5. Choose Find to start the search.

Customizing your Blazer web browser settings

1. Press Menu .
2. From the Options menu, choose Preferences.
3. Set any of the following preferences:

• Home Page: Sets the web page that appears when you choose the Home icon.
• Restore Default: Resets the home page to the factory setting.
• Initial View: Determines which view displays when you launch Blazer.
• Don’t show images: Selects whether you want images to appear when you load 

a web page. If you don’t view images, web pages will load faster.
Browsing the web   ::   61



62   ::   Browsing the w
4. Choose Advanced and set any of the following preferences:
• Set limit on memory for storing recently viewed pages (cache): Sets the 

amount of memory used for your cache. Pages are cached so they load faster 
the next time you view them.

• Memory Management: Enables you to free up memory on your phone by 
clearing the memory for recent pages, history, and cookies.

• Set Proxy: Sets up a proxy server to access the Internet. If your connection 
requires a proxy server, please contact your Internet service provider or IT 
administrator for this information.

• Accept cookies: Allows some web sites to store personalized information on 
your Treo. Some sites do not work properly unless you select this option.

5. Choose OK.

Disconnecting from the Web
When you are done viewing information on the web, you can keep a dormant data 
connection open or you can close the connection and disconnect from the web.

1. Press Applications Launcher . 
2. Choose the pick list in the upper-right corner, and then select All.
3. Choose the Prefs icon. 
4. Choose the pick list in the upper-right corner, and then select Network.
5. Choose Disconnect.
eb



When using the camera in 
low light, you may see blue 
dots on the screen, 
especially in the darker 
areas. Once you capture 
the picture, image quality 
improves.

You must set up 
the Mail 
application on 
your phone before 
you can send a 
picture (see 
page 73).
Working with pictures

Your Treo comes with an easy-to-use built-in camera, which allows you to instantly 
take, view, and share pictures with friends and family. To add a personal touch to your 
phone, you can use your pictures as wallpaper on the Main Phone screen and as 
caller ID images (see page 118).

You can move pictures to a Windows computer by performing a HotSync 
operation. Pictures are 16-bit color at a maximum of 640x480 resolution 
(0.3 megapixels). 

Taking a picture
1. Press Phone .
2. Press Right  to launch Pictures. 
3. Point the lens on the back of your Treo at the subject you want to photograph.
4. Press Center to capture the picture.
5. If desired, edit the picture name and category at the top of the screen.
6. Choose Save to keep the picture, choose Don’t Save to discard it, or choose Send 

to send the picture and save it at the same time.
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To view other full-size 
pictures, choose Prev or 
Next.

You cannot send 
copyrighted pictures that 
appear with a lock icon in 
the Pictures view.

You can reduce the size of 
an image before sending it. 
From the Picture menu, 
choose Downsize. Indicate 
whether you want to resize 
the original or save a 
reduced copy.
Viewing a picture

1. Choose the Pictures view icon .
2. Choose the picture you want to view. 
3. Choose Done.

Sending a picture
You can send a picture to friends and family by attaching it to an email message. 
However, you must set up the Mail application on your phone before you can send a 
picture (see page 73).
1. Make sure Wireless Mode is turned on, as described on page 15.
2. From the Pictures view, choose the picture you want to send. 
3. Choose Send.
4. After the Mail application launches, address and send the message (see page 75). 

Moving pictures
1. From the Pictures view, choose the picture you want to move. 

2. Press Menu .
3. From the Picture menu, choose Move (/M).
4. Choose the category or expansion card where you want to move the picture.
5. Choose Move to finish. 
ctures



You can rename a picture. 
From the Picture menu, 
choose Edit Name.

Move or copy a picture to 
your SD card. Select a 
picture, then press Menu. 
From the Picture menu, 
choose Move, then choose 
your SD card from the pick 
list. See page 111 for more 
information on using 
expansion cards.
Deleting a picture
1. From the Pictures view, choose the picture you want to delete. 
2. Choose Delete.
3. If prompted, choose OK to confirm deletion.

Customizing your Pictures settings
1. From any view in the Pictures application, press Menu .
2. From the Options menu, choose Preferences.
3. Set any of the following preferences:

• Default name: Names a series of pictures to be captured, such as Seattle001, 
Seattle002, etc. 

• Category: The default category for newly captured pictures.
• Picture size: The default size for newly captured pictures. Large is 640 x 480 

pixels, small is 160 x 120 pixels.
• Play capture sound: Plays a sound to confirm picture capture.
• Confirm before deleting: If checked, Pictures asks if you’re sure you want to 

delete a picture before erasing it.
• Confirm before saving: If checked, Pictures asks if you’re sure you want to save 

a picture before storing it on your Treo.
• Backup settings: When activated, backs up the Treo image database on your 

desktop computer.
4. Choose OK.
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Viewing pictures on your computer (Windows only)
When you perform a HotSync operation, your Treo images are copied to your desktop 
computer. You can view these pictures in JPEG format, or email them to friends using 
your desktop email application.
1. Locate your Pictures folder. This is most likely at C:\Program Files\palmOne\Treo 

Pictures\(user name) or if you upgraded from another Palm Powered device, at 
C:\Program Files\Palm\Treo Pictures\(user name) or C:\Program 
Files\Handspring\Treo Pictures\(user name).

2. Double-click any file to view it with the default picture viewing software on your 
Windows computer.
ctures



When entering a message, 
you can insert emotive 
symbols by choosing 
Emoticons or predefined 
QuickText phrases. To add a 
new phrase, select Edit 
QuickText from the list.

Not all symbols available 
on your device may be 
used in text messages. The 
SMS application 
automatically replaces 
invalid characters before it 
sends your message.

You can address text 
messages to multiple 
recipients by separating the 
addresses with a comma. If 
you address a single 
message to three people, 
you will be billed for three 
messages.
SMS

Text messages are brief notes that you exchange with other mobile phones that have 
text messaging capability (also known as short messaging or SMS). Messages must 
be 140 characters or less. Refer to your service plan for per-message pricing and 
availability. 

Creating and sending a message
1. Make sure Wireless Mode is turned on, as described on page 15.
2. Press SMS .
3. Choose New.

4. If the recipient is in your Contacts list, start typing the first initial and last name (no 
spaces). Otherwise, type the full phone number, email address, or alias. 

5. Press Down . If you typed just a few letters of the recipient’s name, choose the 
recipient’s phone number or email address from the list that appears.

6. Type your message.
7. Choose Send.
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When available, the alert 
and message show the 
sender’s name and phone 
number. In some cases, the 
sender’s privacy settings 
may block this information.
Receiving messages
When your phone is on and in an area of wireless coverage, you will automatically 
receive text messages sent to you. You can configure your Treo to automatically notify 
you when new text messages arrive, using a ringtone and vibration or simply an 
onscreen alert. 

From the New Message alert:
• To view your message(s), choose Go To.
• To dismiss the alert, choose OK. The message goes straight to the Inbox.
• To be reminded of the new message again in 5 minutes, choose Snooze.

Using links in messages
When you receive a text message that contains a telephone number, email address, or 
URL, you can dial the number, send an email message, or go to the web page 
immediately. 
1. Choose a message from the list.
2. Choose the phone number, email address, or URL (appears as underlined blue text).
3. Your Treo automatically launches the appropriate application from the link.



If you are out of a coverage 
area or if Wireless Mode is 
off, outgoing messages go 
into the outbox. When you 
return to a coverage area, 
messages are sent 
automatically.

You cannot set the priority 
of outgoing messages.
Managing your messages
The status icons that appear next to each message in the Inbox, Outbox, and Sent 
folders indicate the following: 

• An incoming message. Unread messages appear in bold; messages you’ve 
read appear in plain text. Urgent messages appear with a red exclamation point !, 
and low-priority messages appear with a blue arrow.

• An item that is locked and cannot be deleted or purged until you unlock it. 

• An outbound message that is waiting to be sent or a message that was sent 
and has not yet been received. 

• A chat session. Chats containing unread incoming messages appear in bold 
text.

In list view you can rearrange the messages in any folder using the Sort command. 
1. From list view, press Menu .
2. From the View menu, choose Sort by Name or Sort by Date. 

In list view you can delete several messages at once from any folder using the Purge 
command.
1. From list view, press Menu .
2. From the Message menu, choose Purge (/K).
3. Choose the Purge pick list, and then select an option.
4. Choose OK.
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Text messages can be sent 
and received even while 
you are on a phone call. 
This is easiest when using 
the hands-free headset or 
speakerphone.

To find a chat you had with 
someone, open your SMS 
Inbox and select a chat 
session.
Chatting with SMS
When you exchange more than one text message with a single contact, your 
messages are grouped into a chat session. The upper part of the Chat view displays 
all messages you’ve exchanged with this contact, and the lower part provides a text 
entry area. You can carry on multiple chats at the same time and easily switch 
between them, using the pick list at the top of the screen.

1. From the Inbox, choose a chat.
2. Type your message.
3. Choose Send.



Customizing your SMS settings

1. Press Menu .
2. From the Options menu, choose Preferences.
3. Set any of the following preferences:

• Messages: Your preferences for individual text messages.
• Confirm message deletions: Indicate whether you want deletion confirmation 

messages to appear.
• Return to list view after delete: Indicate whether you want to return to the list 

view or the next item in the folder after deleting a message.
• Addressing new messages: Indicate whether you want the keyboard to 

default to letters or numbers when you type an address.
• Message validity period: Indicate how long you want your wireless service 

provider to attempt to deliver the message. If the message can’t be delivered 
within the specified time period, the message is discarded.

• Chat: Your preferences for chat sessions.
• Show timestamps in chats: Indicate whether you want to see timestamps in 

the Chat screen.
• Display my name in chat window as: Enter the name you want displayed as 

the label for your messages in the Chat screen.
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• Label color: Select the color in which you want messages to appear.
• Use color for: Indicate whether you want to view both the message label and 

message in a different color, or only the name.

4. Choose OK.



The Mail application is 
compatible with regular 
POP3 email accounts. 
Other accounts, such as 
corporate or web-only 
email, require special 
applications, if available.
Sending and receiving email

If you have activated data services, you’re ready to set up your Treo for email. These 
steps differ depending on who provides your email service.
• Mail: The built-in email application on Treo that provides wireless access to an 

existing POP3 email account. See the sections that follow for details.
• Other wireless email services: Your wireless service provider may offer a wireless 

email service to which you can subscribe with your service plan. Contact your 
wireless service provider for details.

• Third-party email applications: A number of third-party developers offer Palm OS 
email applications. Consult the email application’s documentation to learn how to 
set it up.

Setting up Mail
The first time you use Mail, you need to set it up on your Treo. If you have multiple 
email accounts, you can set up Mail to access more than one account. To use Mail, 
you must have:
• Wireless account with data services activated.
• Email account with an email service provider that supports the POP3 protocol. 

Examples include Sympatico, Earthlink, SBC, and AT&T Worldnet. Contact your 
email provider to determine if your account is POP3-compatible. If it is not 
compatible, contact your wireless service provider to learn about their corporate 
email solutions, or use a third-party solution.
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To address a message to 
several people, separate 
each address with a 
comma or space. When 
you’re finished adding 
addresses press Center to 
finish.

If you receive an error 
when sending a message, 
you may need to specify an 
SMTP server for your email 
account, or add other 
security preferences before 
you can send emails. For 
more information, see the 
troubleshooting tips on 
page 148.
1. Press Applications Launcher.
2. Choose the Mail icon. 
3. Choose the pick list, and then select your email service provider. If your email 

service provider is not listed, select Other.

4. Choose Next. 
5. Type your Full Name (as you want it to appear when you send messages), your full 

Email Address, your User Name, and your Password for this account. If you’re 
setting up a Sympatico account, enter your full email address as your User Name.

6. If you selected Other from the pick list earlier, choose the tabs for Server and 
Advanced, and enter the necessary information. If you do not have this information, 
contact your email service provider to obtain it. For SMTP, enter the regional SMTP 
server provided by your wireless service provider.

7. Choose OK to continue.
8. Choose Done.
eiving email



To send a copy or blind 
copy, choose Cc or Bcc, 
select those lines and enter 
the address(es) in those 
fields. See page 80 for 
details on displaying the 
Bcc field.

To save a message without 
sending, choose Cancel 
(instead of Save), and then 
choose Yes in the Save 
Draft screen.

You can attach other types 
of third-party files to an 
email if the third-party 
software supports the 
“Send” command. Launch 
the third-party application, 
open the item in question, 
press Menu, and choose 
“Send” if available.
Creating and sending messages
1. From the Inbox, choose New.
2. Begin typing the addressee’s email address, first name, or last name. Mail 

remembers your most recent addressees and suggests choices. To accept a 
suggestion, press Down . To send to a different address, keep typing the email 

address or name.

3. Enter the subject and message text. To move between fields, press Up  or Down .
4. Choose Send to connect and send all messages immediately. Or, choose Send 

Later to put this message into your Outbox.

Attaching ringtones and images to your messages
1. Create the message to which you want to attach the item.
2. From the New Message screen, press Menu .
3. From the Options menu, choose Insert Attachment.
4. Choose the type of item you want to attach.
5. Choose the specific item you want to attach.
Sending and receiving email   ::   75



76   ::   Sending and rec

You can also reply to all 
addressees. Choose the 
Respond button, and then 
choose Reply All.

If you want your Treo to 
check your email 
automatically, change the 
Delivery preference.
Attaching applications to your messages
You can create a new email with a Palm OS application attached (subject to copyright 
restrictions). 

1. Press Applications Launcher .

2. Press Menu .
3. From the App menu, choose Send.
4. Choose the application you want to send. If the application has a lock icon  next 

to it, it is protected and can’t be attached. 
5. Complete the message and send.

Receiving and viewing messages
By default, your Treo automatically sends and receives messages (see page 80 for 
more details). You can manually send and receive messages on-demand as described 
below.
1. Make sure Wireless Mode is turned on (see page 15).
2. From any mailbox, choose Send and Receive.
3. From the Inbox, choose the message you want to view.

4. When viewing the message text, press Option  and Left  or Right  to view 
the previous or next message.

5. Choose Done to return to the Inbox.
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If a large incoming 
message is truncated, go to 
the Message menu, and 
then choose Get Entire 
Message.

If you have problems 
receiving email, see the 
troubleshooting tips starting 
on page 148.

To hear sound file 
attachments, press Menu. 
From the Attachments 
menu, choose Open.

You can also use the 
system Find dialog to 
quickly scan your mailbox. 
Press Option and 
Shift/Find.
Replying to or forwarding messages
When you respond to messages, you can choose whether to include the original text 
(see page 80).
1. From the Inbox, Filed, or Deleted folder, open the message to which you want to 

respond.
2. From the Message view, choose Respond to reply. To reply to all or forward, choose 

the appropriate button.
3. Enter your reply.
4. Choose Send to finish.

Viewing attachments
There are a number of attachment types you can open with the built-in software on 
your Treo (e.g. ringtones, pictures). You can open other types of attachments by 
installing third-party applications. In Message view, attachments appear with the 
paperclip icon  if they are unsupported on Treo. If attachments are supported on 
Treo, they appear with the icon for the associated program (e.g. the camera  icon 
for pictures).
1. From any folder, open the message with the attachment you want to view.
2. Choose the attachment icon.
3. Follow the prompts from the viewing application.
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To empty (or purge) the 
Deleted folder, go to the 
Message menu, and then 
choose Empty Deleted 
Items (/E).
Managing your messages
The status icons that appear next to each message in your Inbox indicate the 
following: 

• You have not read the message

• You have read the message

• The message includes an attachment

You can rearrange the Mail list to make it easier to find and view messages. 

• From the Mail list view, press Menu , and then from the Options menu, choose 
one of the following: Sort by Date (/Z), Sort by Name (/Y), Sort by Subject (/J).

• To quickly switch between folders in the list view, choose the folder pick list in the 
upper-right corner, and then select the desired folder.

Deleting selected messages from the Inbox
When you delete a message from the Inbox, it moves to the Deleted folder which 
stores the 200 most recently deleted messages. If you delete more than 200 
messages, the oldest messages are automatically removed from the phone. 
1. Highlight the message you want to delete. To highlight a group of messages, press 

Shift  and Up  or Down .
2. Press Backspace .
3. If a confirmation dialog appears, choose OK to confirm the deletion.
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Deleting messages by the date
You can quickly delete a group of messages by selecting a range of dates.
1. Press Menu .
2. From the Message menu, choose Purge (/K).
3. Choose a date range for the messages you want to delete.
4. Choose OK.
5. If a confirmation dialog appears, choose OK to confirm the deletion.

Switching accounts

• To switch between different email accounts, press Menu , and then from the 
View menu, choose an account.
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Remember, your Mail 
preferences (including 
automatic delivery) are set 
for the individual account 
currently displayed. If you 
have multiple accounts, 
configure each account 
separately.
Customizing your Mail settings
If you have multiple email accounts, you can customize the Mail settings for each 
individual account on your Treo. Remember, the preferences you set will only apply to 
the email account you are currently viewing.

1. Press Menu .
2. From the Options menu, choose Preferences.
3. Set any of the following Delivery preferences:

• Get mail: Sets the interval for mail delivery. If you select an automatic delivery 
option, you can also select the hours during which you want automatic delivery.

• For each message get: Sets the maximum size for incoming messages. 1K of 
information is about 4 screens of text on your Treo.

• Only get mail from last ## days: Specifies the timeframe for retrieving earlier 
messages.

• Auto-deliver even when roaming: Specifies whether you can continue 
automatically retrieving your email when you are not in your wireless plan’s 
home area (which may incur additional charges on your account). This option 
applies only if you selected an automatic delivery option.
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If you want to access more 
than one email account 
with your Treo, choose Add 
Account.

If you assign Mail to an 
application button, you can 
press and hold that button 
to send and receive mail. 
This is very useful for 
discreet mail checking.
4. Choose the Delete tab and set any of the following preferences:
• Confirm message deletion: Asks if you’re sure you want to delete a message 

before erasing it.
• Return to list view after deleting a message: Shows the Mail list view after you 

delete a message, if checked, or shows the next message in the list, if 
unchecked.

5. Choose the Message tab and set any of the following preferences:
• Include original text when replying: Appends the full text of the original 

message when you reply to a message.
• Include attachments when forwarding: Sends attachments as well as the 

original message when forwarding, even if you cannot open an attachment on 
Treo.

• Always show Bcc: Displays the Bcc field when creating messages and allows 
you to pre-fill this field with a default address (useful for creating a backup copy 
of email that is sent to your email server).

• Signature: Controls what messages have your signature automatically 
appended to them and lets you define a custom signature.

6. Choose OK.
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first two weeks:

using 
organizer 
features
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If you have several 
appointments to enter, it’s 
more efficient to use 
Palm® Desktop software 
or Microsoft Outlook on 
your computer and then 
synchronize data between 
the Treo™ 600 
smartphone and your 
computer. For more 
information, see page 32.
Calendar 

Displaying your calendar

• Press Calendar  repeatedly to cycle through the various active views.

• Use the 5-way navigation control to move to another day, week, or month 
(depending on the current view).

• Choose Go or press Menu . From the Options menu, choose Go to Day (/O) 
choose a date from the calendar.

Creating an event

1. Press Calendar  until you are in Day view.

2. Press Left  and Right  to select the desired day.
3. Using the keyboard, type a starting time for the event. For example, type 53 for 

5:30 (Remember to press Option  before typing numbers).

4. Press Down  and type the ending time for the event.
5. Choose OK. 



The silent alarm for 
untimed events is defined 
by minutes, days, or hours 
before midnight of the date 
of the event.

When an alert occurs, the 
Reminder screen displays 
all your Treo’s pending 
alerts. Tap an item’s 
description to jump to that 
item, or check the box to 
clear that item.
6. Type a description for the event.

Adding an alarm reminder to an event
1. In Calendar, highlight the event.
2. Choose Details.
3. Check the Alarm box and choose the number of minutes, hours, or days before the 

event you would like to receive the alarm.
4. Choose OK.

A. Selected date
B. Starting and ending times
C. Selected day

A. Type of time units
B. Number of time units
C. A diamond indicates an untimed event.
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To enter a birthday or 
anniversary, create an 
untimed event. Then, from 
the Details screen, choose 
Year as the repeat interval.
Creating an untimed event
An untimed event, such as a birthday or anniversary, does not occur at a particular time.

1. Press Calendar  until you are in Day view. 

2. Press Left  and Right  to go to the date of the event.
3. Make sure nothing is highlighted.
4. Type a description for the event.

Editing or deleting an event
1. Highlight the event you want to reschedule.
2. Choose Details.
3. Change the date and time as needed, or choose Delete.
4. Choose OK.

Scheduling a repeating event
1. Create an event, and then highlight it.
2. Choose Details.
3. Choose the Repeat box, and then choose a repeat interval. 
4. For weekly events, choose the day(s) the event repeats; for monthly events, choose 

the Day or Date option.



5. If the event has an ending date, choose the End on pick list, and then select 
Choose Date, and select the ending date.

6. Choose OK.

Customizing general preferences for your calendar

1. Press Menu . 
2. From the Options menu, choose Preferences (/R).
3. Set any of the following preferences:

• Start Time and End Time: The beginning and end of the day shown on Calendar 
screens.

• Event Duration: The default duration of a new event.
• Week Start: The day on which the calendar week starts.
• Initial View: The view that appears when you launch Calendar.

A. This icon indicates a repeating event.
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• Button Views: The views that appear when you press Calendar  repeatedly. 
By default, you see Day and Month Views, but you can also see Week, Week 
with Text, Year, and Daily Journal Views.

• Display Options: Your choices for different Calendar view options:
• Show Time Bars: Shows the duration of an event and illustrates conflicts.
• Compress Day View: When off, all time slots display. When on, start and end 

times display for each event, but blank time slots disappear to minimize 
scrolling. 

• Show PM Label: Displays a p after PM times.
• Show End Times: Displays all time bars and time slots for end times of an 

event.
• Auto-scroll Time: Displays events based on the time of day when there is 

more than one screen of information. The arrows at the bottom-right corner 
indicate more information.

• Float Advance at Midnight: Advances floating events to the next day at 
midnight of the current day.

• Show Completed Floating Events: Displays completed floating events.
4. Choose OK to close the Display options dialog.
5. Choose OK.



Customizing To Do List preferences for your calendar
You can display To Do items in your calendar to keep on top of your tasks.

1. Press Calendar  until you are in Day view.
2. Press Menu .
3. From the Options menu, choose To Do Preferences.
4. Set any of the following preferences:

• Show Categories: Determines which To Do categories appear.
• Priorities Displayed: Limits the To Do items to certain priorities.
• Show Priority: Displays the priority assigned to an item.
• Show Completed Items: Displays checked off items.
• Show Undated Items: Displays items that do not have a Due Date assigned.
• Show Dated Items: Displays To Do items that have a Due Date assigned. 

5. Choose OK.
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You can set To Do List to 
record the date that you 
completed the To Do item, 
and you can choose to 
show or hide completed 
items. Completed items 
remain in the memory of 
your phone until you purge 
them.

To save memory, you can 
purge all completed To Do 
items. From the Record 
menu, choose Purge. 
Choose OK to finish.

You can display To Do 
items in your calendar. See 
page 89 for information on 
customizing To Do 
Preferences for your 
calendar.
To Do List 

You can use To Do List as a reminder of tasks you need to complete and to keep a 
record of complete tasks. 

Adding a To Do item

1. Press Applications Launcher .
2. Choose the pick list in the upper-right corner, and then select All.
3. Choose the To Do List icon. 
4. Choose New to create a new To Do item
5. Type the text of the To Do item. The text can be longer than one line.

6. Press Down  to deselect the To Do item.

Setting item priority, due date, and other details
The Details dialog enables you to assign a priority level, due date, category, privacy 
flag, and note to each item. 
1. Highlight the item to which you want to assign details.
2. Choose Details.



Press Menu to access 
other features such as 
importing phone numbers 
into To Do List.
3. Set any of the following: 
• Priority: Choose the Priority number for this item (1 is most important). Later you 

can arrange your To Do items based on the importance of each item.
• Category: Assign the item to a specific category.
• Due Date: Choose the Due Date pick list, and then select a due date for the 

item.
• Private: Check this box to mark this item private.
• Note: Enter additional text you want to associate with the item.

4. Choose OK.

Checking off a To Do item
1. Choose the item you want to check off.
2. Hold Option  and press Return .

Deleting a To Do item
1. Highlight the item you want to delete.

2. Press Menu .
3. From the Record menu, choose Delete Item (/D).
4. Choose OK.
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To uncheck the selected 
item, hold Option and press 
Return.

If you turn on the Show 
Due Dates option in the To 
Do Preferences screen, you 
can tap directly on the due 
date in To Do List to choose 
a new date.
Customizing To Do List
The To Do Preferences screen enables you to control the appearance of To Do List.
1. In To Do List, choose Show.
2. Set any of the following preferences:

• Sort by: Indicates the order in which your To Do items appear in the list.
• Show Completed Items: Displays items you’ve checked off.
• Show Only Due Items: Hides items that are not yet due.
• Record Complete Date: Replaces due date with the completion date when you 

complete (check) the item.
• Show Due Dates: Displays item due dates, and inserts an exclamation mark 

next to overdue items.
• Show Priorities: Displays the priority setting for each item.
• Show Categories: Displays the category for each item.

3. Choose OK.



Each Memo Pad item can 
include 4,096 characters of 
text.

You can assign categories 
to Memo Pad items. Open 
the item you want to assign 
a category to, choose the 
pick list in the upper-right 
corner, and then select a 
category.
Memo Pad 

Memos are a great way to store notes on your Treo. 

Creating a memo

1. Press Applications Launcher .
2. Choose the pick list in the upper-right corner, and then select All.
3. Choose the Memo Pad icon.
4. Enter the text you want to appear in the memo. 
5. Choose Done.

Deleting a memo
1. Choose the memo you want to delete.
2. Press Menu .
3. From the Record menu, choose Delete Item (/D).
4. Choose OK.
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CityTime

The CityTime world clock displays the day and time in your home city and in four other 
cities around the globe. Whether you’re traveling or at home, it’s easy to keep track of 
the best time to reach your business associates, friends, and family in faraway places.

Setting your Home City
The Home City serves as a point of reference for your other city selections. The Home 
City time reflects the current system time (unless you have changed locations, see 
page 95). The information displayed for all the other cities is based on the day and 
time in your Home City.

1. Press Applications Launcher .
2. Choose the pick list in the upper-right corner, and then select All.
3. Choose the CityTime icon.
4. Press Menu .
5. From the Options menu, choose Select Home City (/H).
6. Choose the Home City pick list, and then select the city closest to your location (in 

the same time zone).
7. Choose OK.

A. Home City



CityTime does not 
automatically update the 
system time for Daylight 
Savings Time.

Run your stylus over the 
map to see the time in 
other cities.

The shadow over the map 
represents nighttime 
moving across the globe.
Selecting remote cities
In addition to your Home City, you can display the day and time for four other cities, 
called remote cities, anywhere around the globe.
1. Use the stylus to tap a pick list in the lower part of the CityTime screen, and then 

select the city closest to the city you want to display.
2. Choose the remaining pick lists, and then select the other three cities you want to 

display.

Adding cities
If the city you want to display is not in the predefined list, you can add it.

1. Press Menu .
2. From the Options menu, choose Edit Cities (/E).
3. Choose New.
4. Enter the city name and other information.
5. Choose OK.

Changing locations
If you travel, you can easily coordinate the system time on your Treo with the local 
time.

1. Press Menu .
2. From the Utilities menu, choose Change Location (/L).
3. Choose the To pick list, and then select your new location.
4. Choose OK.
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You can tap the screen or 
use the keyboard to input 
numbers.
Calculator

Calculator includes a basic calculator, plus an advanced calculator with scientific, 
financial, and conversion functions. 

Switching between Basic and Advanced Calculator modes

1. Press Applications Launcher .
2. Choose the pick list in the upper-right corner, and then select All.
3. Choose the Calculator icon.
4. Press Menu . 
5. From the Options menu, choose Toggle Mode (/M).

Selecting functions in Advanced Calculator mode
1. Switch to Advanced Calculator mode (see above).
2. Choose the pick list near the upper-left part of the screen, and then select the 

Advanced Calculator function you would like to use:
• Math: Advanced mathematical functions such as exponents, roots, and 

logarithms.



Choose Sto to store a 
number in one of ten 
memory slots. Choose Rcl 
to recall a stored number.

Choose Con to access a list 
of mathematical constants 
such as Avogadro’s number 
or the speed of light.
• Trig: Trigonometric functions such as sine, cosine, tangent, and variants.
• Finance: Financial calculator functions such as APR and amortization.
• Logic: Hexadecimal characters in keypad, plus logic functions such as and, not, 

or, and xor. In place of Float/Degrees (see below), this view includes options for 
class (bin, oct, SDec, UDec, hex) and bits (8, 16, 32).

• Statistics: Statistical functions such as sum, factorial, and random number 
generator.

• Weight/Temp: Weight and temperature conversions for metric and English 
values.

• Length: Length conversions for metric and English values.
• Area: Area conversions for metric, traditional, and English values.
• Volume: Volume conversions for metric and English values.

3. Choose the pick list near the upper-middle of the screen, and then select how to 
display decimal values:
• Float (Floating point): Position of decimal point varies according to calculation 

results.
• Fixed(x) (Fixed point): Enter an integer for the number of decimal places to 

display, and then select Fixed(x) to round calculations to that decimal place.
• Sci(x) (Scientific notation): Enter an integer for the number of decimal places to 

display, and then select Sci(x) to round calculations to that decimal place using 
scientific notation.
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• Eng(x) (Engineering notation): Enter an integer for the number of decimal 
places to display, and then select Eng(x) to round calculations to that decimal 
place using engineering notation.

4. Choose the pick list near the upper-right of the screen, and then select whether 
you want to display numbers in degrees, radians, or grads.



To access Name Lookup in 
other applications, choose 
the Lookup button if it 
appears.
Looking up contacts and other 
information

With the built-in search features on your Treo, you can find information quickly:
• Name Lookup: Enables you to dial your Contacts by name. It locates people’s 

phone numbers when you’re in the Contacts list.
• Find: Searches through the text in all the applications on your Treo.

Name Lookup
You can access Name Lookup directly from the Contacts list. This feature helps you 
locate Contacts quickly by entering just a few letters of a Contact’s name.

1. Press Phone .
2. Use the 5-way navigation control to access the Contacts list.
3. From the Contacts list, enter the first few letters of the Contact you want to find. 

You can enter:
• First name (joh for John) or
• Last name (smi for Smith) or
• First name initial and last name (jsm for John Smith)
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To search by company for a 
name you can’t remember, 
open Find, and type the 
name of the company.

Find is not case-sensitive 
and it locates any word 
that begins with the text 
you enter. For example, 
entering plan finds planet, 
but not airplane.

Find searches through one 
screen’s worth of 
information at a time. At 
first, you may see search 
results from one 
application, or several. If 
you don’t find what you 
need on the first screen, 
choose Find More to check 
other applications.
For example, entering SM displays Smilla Anderson, John Smith, and Sally Martin 
as shown above. Entering JSM finds only John Smith.

4. Do one of the following:
• Highlight the contact name, and then press Center to view the contents of the 

record.
• Highlight any phone number, and then press Center to dial.

Using Find
The Find feature locates any text in the built-in applications and databases, and in 
some third-party applications. The Find feature performs an exact search on a 
character string and locates any words that begin with the text you enter.

1. Press Option , and then Shift  to open the Find dialog.
2. Enter the text you want to find. 
3. Choose OK to start the search.
ntacts and other information



4. In the search results, choose the text you want to review, or choose Find More to 
search additional applications.
Looking up contacts and other information   ::   101



102   ::   Beaming infor

You can store a beamed 
application on your phone, 
or send it to an expansion 
card inserted in the 
expansion slot.

Beam your business card 
in two key presses: in any 
Phone view, press Menu 
press M.
Beaming information 

Your Treo is equipped with an IR (infrared) port that lets you beam information to 
another Palm Powered™ device with an IR port. The IR port is located on the top of 
your Treo, between the Wireless Mode button and the ringer switch, behind the small 
dark shield. 

Beaming a record
1. Choose the record or category you want to beam.

2. Press Menu .
3. From the Record menu, choose one of the following:

• Beam (/B): Sends an individual record. 
• Beam Category (/Y): Sends all records in the current category.

4. When the Beam Status dialog appears, point the IR port on your Treo directly at the 
IR port of the receiving device.

5. Wait for the Beam Status dialog to indicate that the transfer is complete before you 
continue using your Treo.
mation



For best results, the path 
between the two devices 
must be clear of obstacles, 
and both devices must be 
kept stationary. If you have 
difficulty beaming, shorten 
the distance and avoid 
bright sunlight.

If you do not choose a 
category upon receiving a 
beamed item, the item is 
placed in the Unfiled 
category.

If you can’t receive beamed 
information, try a soft reset 
(see page 139).
Beaming an application

Not all applications can be beamed. A lock icon  appears on the Beam screen next 
to applications that cannot be beamed.

1. Press Applications Launcher .

2. Press Menu .
3. From the App menu, choose Beam (/B).
4. Choose the Beam From pick list, and then select whether the application you want 

to beam is located on your Treo or an expansion card.
5. Choose the application you want to transfer.
6. Choose Beam.
7. When the Beam Status dialog appears, point the IR port on your Treo directly at the 

IR port of the receiving device.
8. Wait for the Beam Status dialog to indicate that the transfer is complete before you 

continue using your Treo.
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Receiving beamed information
1. Turn on your screen.
2. Point the IR port on your Treo directly at the IR port of the transmitting device to 

open the Beam Status dialog.
3. When the Beam dialog appears, choose a category for the entry.

4. Press Up  to receive the beam or press Down  to refuse it.
mation



first month:

managing 
applications
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On a Windows computer, 
you can also access the 
Install Tool dialog by 
selecting Install Tool under 
palmOne™ on the Start 
menu or from the 
Programs folder.
Installing applications

Your Treo™ 600 smartphone comes with several built-in applications that are ready to 
use. You can also install third-party Palm OS® applications, such as business 
software, games, and more. To learn more, go to www.palmOne.com/software.

When you download an application to your computer, it is probably in a 
compressed format such as a .zip or .sit file. If the file is compressed, you need to use 
a decompression utility on your computer before you install the application on your 
Treo. 

These instructions tell you how to install basic .prc (Palm OS application) and .pdb 
(Palm OS database) files onto your Treo. Some Palm OS software uses an installer or 
wizard to guide you through the process. Consult the documentation that came with 
the software for details.
cations
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Before you can install an 
application on your Treo, 
you need to have 
Palm® Desktop software 
installed on your computer 
(see page 31).
Installing applications from a Windows computer
1. Double-click the .prc or .pdb file you want to install on your Treo.
2. A dialog may appear with a User drop-down list. Select your User Name from the 

list.
3. The Install Tool window appears. If you would like to install additional files, simply 

drag and drop them into the space in this window.
4. If you want to install an application to an expansion card, click Change Destination. 

Click the arrows to move the application to the expansion card pane, and then click 
OK.

5. Click Done.
6. Perform a HotSync® operation to install the application(s) on your Treo.
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Installing applications from a Macintosh computer
1. On your Macintosh, launch Palm Desktop.
2. From the HotSync menu, choose Install Handheld Files.
3. Select the User Name that corresponds to your Treo phone from the User drop-

down menu.
4. Click Add To List.
5. Locate the .prc or .pdb file you want to install on your Treo. Highlight it and click 

Add File.
6. Perform a HotSync operation to install the application(s) on your Treo.

Getting help with third-party applications
If a you encounter a problem (such as an error message) with a third-party application, 
contact the application’s author or vendor. For general troubleshooting of third-party 
applications, see page 153. 
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Some applications are 
factory-installed in your 
phone and cannot be 
deleted. These are listed 
with a lock icon next to 
them.

If you upgraded from a 
previous version of 
Palm Desktop software, 
your backup folder may be 
located in the Palm folder.

Applications deleted from 
your phone are kept on 
your computer, in the 
Archive folder of your user 
folder.
Removing applications

If you decide that you no longer need an application, or want to free up memory on 
your Treo, you can remove applications from your Treo or an expansion card (for more 
on expansion cards, see page 111). You can remove only applications, patches, and 
extensions that you install; you cannot remove the built-in applications that reside in 
the ROM portion of your Treo.

1. Press Applications Launcher . 
2. Press Menu .
3. From the Options menu, choose Delete (/D).
4. If you want to remove an application from an expansion card, insert the card into 

your Treo.
5. Choose the Delete From pick list, and then select the location of the application 

you want to remove.
6. Choose the application that you want to remove.
7. Choose Delete to finish.
8. Perform a HotSync operation to remove the application from the Backup folder on 

your computer.

If the application re-appears on your device, you 
may need to manually delete it from your computer. 
Locate your Backup folder on your computer 
(Windows: C:\Program Files\palmOne\user name; 
Macintosh: Mac HD\Applications\palmOne
\Users\user name). If you find a .prc or .pdb file for 
the application you just removed, delete the file 
from the Backup folder.
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Using Application Info

The Info screens display basic statistics about the applications on your Treo.

1. Press Applications Launcher .
2. Press Menu .
3. From the App menu, choose Info.
4. At the bottom of the screen, choose the type of information you want to view:

• Version: The version numbers of applications on your Treo.
• Size: The size (in kilobytes) of applications and data on your Treo.
• Records: The number of records in different applications on your Treo.

5. Choose Done.
ion Info



Many SD cards are faster 
than MMC cards for 
reading and writing data.

Warranty does not cover 
damage by Secure Digital 
(SD) cards that do not 
meet SD Memory Card 
Specifications. SD cards 
that do not meet SD 
Memory Card 
Specifications may damage 
Treo 600. 
Using expansion cards

The expansion slot on your Treo enables you to add Secure Digital (SD) cards and 
MultiMedia Cards (MMC) to extend the storage capacity of your Treo. For example, 
SD or MMC expansion cards can store:
• pictures
• MP3 audio files
• games
• eBooks
• applications
• databases
• ... and more

Although expansion cards are sold separately, your Treo includes a mock, non-
functional card inside the expansion slot. When you’re not using a functioning card, 
reinsert the mock card that came with your Treo to protect the expansion slot opening 
and to keep the slot clean. 

Inserting and removing expansion cards
1. Press down and release the mock card.
2. After the expansion slot ejects the mock card, remove the card from the slot.
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When you insert an 
expansion card, the card 
name appears as a 
category with a card icon 
next to the name. To switch 
between the applications 
on the expansion card and 
your phone, choose the 
category pick list in the 
upper-right corner, and 
then select another 
category. 

To run an application on an 
expansion card, you must 
have enough free space in 
the internal memory of 
your Treo to accommodate 
the program.
3. Hold your Treo with the screen facing you, and the card with the notch in the lower-
right corner next to the camera lens.

4. Insert the card into the expansion slot until you feel the card lock into place and 
hear the confirmation tone. 

Launching applications on an expansion card
After you insert an expansion card in the expansion slot, you can launch any of the 
applications stored on the expansion card.
1. Insert the expansion card into the expansion slot. The Applications Launcher 

automatically appears.
2. Choose the icon for the application you want to launch.
3. Press Center to launch the application.

A. Notch
B. Camera lens

A B
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Before you copy an 
application to an expansion 
card, make sure that it is 
compatible with Palm OS 
version 5.2 or higher. Some 
applications do not work 
with expansion cards and 
do not allow you to store 
data files in a location that 
is separate from the 
application.
Copying applications to an expansion card
You can copy applications between your Treo and your expansion card.

1. Press Applications Launcher . 
2. Press Menu .
3. From the App menu, choose Copy (/C).
4. Choose the Copy To pick list, and then select the destination: card name or Phone.
5. Choose the From pick list, and then select the location of the application you want 

to copy: card name or Phone.
6. Highlight the application you want to copy.
7. Choose Copy to finish.
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Viewing expansion card information
The Card Info application displays general information about the expansion card that 
is currently in the expansion slot

1. Press Applications Launcher .
2. Choose the pick list in the upper-right corner, and then select All.
3. Choose the Card Info icon. 

Renaming an expansion card
If you change the contents of an expansion card, you may want to rename the card to 
better match its contents.
1. Insert the expansion card into the expansion slot. The Applications Launcher 

automatically appears.
2. Choose the Card Info icon.
3. Press Menu .
4. From the Card menu, choose Rename Card (/R).
5. Type a new name for the card.
6. Choose OK.

Formatting an expansion card
Formatting an expansion card is similar to formatting a disk on a computer. When you 
format an expansion card, you erase all the data stored on the card.
1. Insert the expansion card into the expansion slot. The Applications Launcher 

automatically appears.
2. Choose the pick list in the upper-right corner, and then select All.
3. Choose the Card Info icon.
4. Press Menu .
5. From the Card menu, choose Format Card (/F).
6. Type a new name for the card.
7. Choose OK.
on cards



when you’re ready:

customizing 
your Treo™ 
smartphone
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You can also adjust the 
ringer volume by pressing 
the volume buttons when 
you’re not on an active call.

Want more ringtones? You 
can download them from 
the web to your phone (see 
page 59).
Phone settings

Selecting ringtones and messaging alert tones
You can set different tones and volumes for incoming phone calls, Calendar alarms, 
and Mail, and SMS messaging alerts.

1. Press Applications Launcher . 
2. Choose the pick list in the upper-right corner, and then select All.
3. Choose the Prefs icon. 
4. Choose the pick list in the upper-right corner, and then select Sound. 
5. Choose the Application pick list select, and then Phone, Mail, Calendar, or SMS.
6. Choose the Volume box.
7. Choose each pick list, and then select an alert volume.
8. Choose the Tones box.
9. Depending on the application, select alert tones from the pick lists that appear: 

• Phone
• Known Caller Tone: An incoming call from someone in your Contacts or 

Favorites.
• Unknown Caller Tone: An incoming call from someone identified by Caller ID 

who is not in your Contacts or Favorites. 
• Roaming Tone: A special tone for incoming calls when you’re outside your 

home wireless network.
• Voicemail Tone: A new voicemail.
• Service Tone: A warning of a service change, such as moving into and out of 

a wireless network coverage area.
 

s



You can also record, 
preview, send, and delete 
sounds on your phone. 
Press Applications 
Launcher, and then choose 
the Sounds icon. Choose 
New, Play, Send, or Edit.
• Mail
• Message Tone: A message arrives with automatic delivery.

• Calendar
• Alarm Sound: The tone played the first time your alarm goes off.
• Reminder Sound: The tone played if an alarm is not acknowledged and the 

alarm repeats.
• Play Sound: The number of times an alert tone will play during the alarm 

sequence.
• Repeat Alarm: The number of times the alarm repeats if not acknowledged.
• Every: The interval between alarm repeats if not acknowledged.
• Alarm Preset: A default for the number of minutes, hours, or days before the 

event that the alarm goes off.
• SMS

• Message Tone: A new text message arrives.
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If you prefer to use the 
onscreen Dial Pad, assign 
the Dial Pad as the default 
wallpaper.

If you remove the Dial Pad 
as the wallpaper, you can 
still access it quickly. Press 
Phone, and then press 
Center.
Adjusting call volume
While on an active call, or while using the personal speakerphone, press the volume 
buttons on the side of your Treo™ 600 smartphone to adjust call volume.

Assigning a caller ID picture and ringtone

1. Press Phone .
2. Press Up  to access your Favorites buttons. 
3. Highlight the Favorites button you want to give a picture caller ID.

4. Press Menu .
5. From the Edit menu, choose Edit Favorites Button (/E).
6. Choose More.

7. Check the Image box, and then choose Select Image. 
8. Choose the picture you want to assign to the selected Favorites button. 
9. Choose Select.
10. Choose the ringtone pick list, and then select a caller ID ringtone.
11. Choose OK.
s



Choosing wallpaper for the Phone screen
If you have images stored on your Treo, you can select different wallpaper for the Main 
view in the Phone application.

1. Press Phone .
2. Press Menu .
3. From the Options menu, choose Display Preferences.
4. Choose the pick list at the top of the screen, and then select Show Wallpaper.
5. Choose the current wallpaper image, and then choose a wallpaper image for your 

Phone screen.
6. Choose Select.
7. OK.
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If the ringer switch is set to 
no sound, the ringer setting 
overrides the sound 
settings and all sounds are 
turned off.

Your Treo includes a silent 
alarm that can vibrate even 
when the ringer switch is 
set to Sound Mode Off. 
System Sound settings 

You can immediately silence all sounds on your Treo, including phone ringtones, 
Calendar alerts, and system sounds. This does not mute the speaker on your Treo 
during a phone call.
1. Slide the ringer switch to Sound Mode Off.
2. To hear all sounds again, slide the ringer switch to Sound Mode On.

When you slide the ringer switch back to the Sound Mode On position, it restores 
the previous sound settings. For example, if the Phone ring volume is set to 7 and 
you slide the ringer switch to Sound Mode Off, you will not hear the phone ring. 
When you move the ringer switch back to Sound Mode On, the Phone ring volume 
is still set to 7.

A. Sound Mode On
B. Sound Mode Off

A B
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The backlight turns off if 
the keyboard is not in use. 

Reducing the contrast and 
brightness settings can 
help conserve battery 
power.
Display and appearance

Turning the keyboard backlight on and off

• To turn the keyboard backlight on, press Option , and the . The backlight 
illuminates the keys, and the screen dims slightly.

• To turn the keyboard backlight off, press Option , and then  again. 

Adjusting the contrast and brightness
Depending on the lighting conditions where you’re using your Treo, you may need to 
adjust the screen contrast and brightness. 
1. Press Applications Launcher . 
2. Choose the pick list in the upper-right corner, and then select All.
3. Choose the Prefs icon. 
4. Choose the pick list in the upper-right corner, and then select Display.

5. Choose the slider , and use Left  and Right  to adjust contrast.
6. Choose the slider, and use Left  and Right  to adjust brightness.

Changing the screen font
You can change the font in Calendar, Contacts, Memo Pad, SMS, and To Do List.
1. Launch the application in which you want to change the font.

2. Press Menu .
3. From the Options menu, choose Font (/F).
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4. Choose a font style:

5. Choose OK.

Aligning the touchscreen
If you tap the touchscreen and your Treo doesn’t respond accurately or activates the 
wrong feature, you may need to realign your touchscreen.

1. Press Applications Launcher . 
2. Choose the pick list in the upper-right corner, and then select All.
3. Choose the Prefs icon. 
4. Choose the pick list in the upper-right corner, and then select Touchscreen. 
5. Follow the onscreen instructions.

Changing the system color scheme

1. Press Applications Launcher .
2. Choose the pick list in the upper-right corner, and then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, and then select General.
5. Choose the Colors pick list, and then select a color scheme.

A. Small font
B. Small bold font
C. Large font
D. Large bold font
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The Applications Launcher 
displays each application 
as an icon. To view them as 
a list instead:
1. Press Applications 

Launcher. 
2. Press Menu.
3. From the Options menu, 

choose Preferences (/R).
4. Choose the View By pick 

list, and then select List.
5. Choose OK.

To create a new category, 
choose the category pick 
list, and then select Edit 
Categories. Choose New, 
and then enter the category 
name. Choose OK to close 
the dialog, and then choose 
OK.
Applications Launcher settings

Arranging applications by category
You can assign an application to a category and then display a specific category of 
applications in the Applications Launcher. 
1. Press Applications Launcher . 
2. Press Menu .
3. From the App menu, choose Category (/Y).

4. Choose the pick list next to each application, and then select a category.
5. Choose Done.

Displaying applications by category
Do one of the following:

• Press Applications Launcher  repeatedly to cycle through the categories.
• Choose the pick list in the upper-right corner, and then select a category.
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You can also pick an 
application to launch from 
the HotSync® button on 
the cable.

To restore all of the buttons 
and key combinations to 
their factory settings, and 
then choose Default.

If you install a new Email, 
Messaging, or Browser 
application on your Treo, it 
appears in the default 
application pick lists if the 
application supports this 
feature. Some third-party 
applications automatically 
assign themselves to a 
particular button. For 
example, email applications 
typically take over the SMS 
button.
Button settings

Buttons Preferences
You can use Buttons Preferences to choose which applications are associated with 
the buttons on your Treo. 

1. Press Applications Launcher . 
2. Choose the pick list in the upper-right corner, and then select All.
3. Choose the Prefs icon. 
4. Choose the pick list in the upper-right corner, and then select Buttons. 
5. Choose the pick list next to the button or key combination you want to reassign, 

and then select an application.
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Setting default applications
Some applications look for other applications to handle data (for example, a mail 
application might launch a browser when you choose a link in an email message). 

1. Press Applications Launcher . 
2. Choose the pick list in the upper right corner, and then select All.
3. Choose the Prefs icon. 
4. Choose the pick list in the upper-right corner, and then select Default Apps. 
5. Choose each pick list, and then select the application you want to associate with 

that function.
Button settings   ::   125



126   ::   Date and time
Date and time settings

Setting the date and time
You can use Date & Time Preferences to set the time, date, time zone, and daylight 
savings setting for your Treo. By default, your phone synchronizes the date and time 
with your wireless service provider’s network when Wireless Mode is on and you’re 
inside a coverage area. To manually set the date and time, follow these steps:

1. Press Applications Launcher . 
2. Choose the pick list in the upper-right corner, and then select All.
3. Choose the Prefs icon. 
4. Choose the pick list in the upper-right corner, and then select Date & Time. 
5. Uncheck the Enable Local Network Time box.
6. Choose the Set Date box. Highlight the current year, month, and date, and then 

press Center to set the date.
7. Choose the Set Time box. Using the stylus, tap the up and down arrows to select 

the current time, and then choose OK to set the time.
8. Choose the Set Time Zone box. Choose the time zone for your location, and then 

choose OK.
9. Choose the Daylight Saving pick list, and then select On or Off.
 settings



The Week starts setting 
controls the Day, Week, 
Month, Year, and List views 
in Calendar and all other 
aspects of your phone that 
display a calendar.
Setting date and time formats
You can use Formats Preferences to choose number conventions based on 
geographic regions. For example, in the United Kingdom, time is expressed using a 
24-hour clock. In the United States, time is expressed using a 12-hour clock with an 
AM or PM suffix. All the built-in applications on your Treo use the Format Preferences 
settings. 

1. Press Applications Launcher . 
2. Choose the pick list in the upper-right corner, and then select All.
3. Choose the Prefs icon. 
4. Choose the pick list in the upper-right corner, and then select Formats. 
5. Set any of the following preferences:

• Preset to: The standard number conventions for your country. When you select 
a country, the other Formats Preferences are automatically set to that country’s 
conventions. You can also edit each option individually.

• Time: The time format. Select HH:MM to display a 24-hour clock.
• Date: The date format.
• Week starts: The first day of the week (usually Sunday or Monday).

6. Numbers: The format for numbers with decimal points and commas.
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The Auto-off setting 
conserves battery power by 
turning off your phone’s 
screen. It does not turn off 
Wireless Mode so you can 
still receive calls, email, 
and text messages after 
the automatic shutoff 
period.

The system and game 
volume settings apply when 
the ringer switch is set to 
the on position.
General Preferences

You can use General Preferences to set the auto shutoff interval, the beam receive 
feature, sounds, and screen colors for your Treo. 

1. Press Applications Launcher . 
2. Choose the pick list in the upper-right corner, and then select All.
3. Choose the Prefs icon. 
4. Choose the pick list in the upper-right corner, and then select General. 

5. Set any of the following preferences:
• Auto-off After: The time that elapses before your screen turns off automatically.
• System Sound: The volume for system beeps and alerts.
• Game Sound: The volume for game sounds.
• Beam Receive: The setting that determines if your Treo can receive beamed 

information.
• Colors: The set of predefined colors for the system display.
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When you receive or make 
a call, the touchscreen on 
the Active call screen may 
be automatically disabled 
to prevent accidental 
termination of a call. You 
must use the 5-way 
navigation control to 
access the buttons on the 
Active call screen. Check 
the Keyguard settings in 
Preferences. 
Locking your phone and data

Your Treo includes several features that help you protect your phone from inadvertent 
use and keep your data private. The built-in security software enables you to use your 
Treo for emergency calls even if the handset is locked.
• Keyguard: Manually disables all buttons and the touchscreen to prevent them from 

being pressed accidentally in your briefcase or pocket.
• Auto-Keyguard and touchscreen lockout: Automatically enables Keyguard after a 

period of inactivity, and lets you disable the touchscreen during an active call or call 
alert.

• Phone Lock: Requires a password to make calls with your phone.
• System password lock: Requires a password to see any data on your Treo.
• Private records: Masks or hides items marked as private, and requires a password 

to view them.

Keyguard
Your Treo includes a feature that locks the keyboard, so that screen items and buttons 
aren’t accidentally pressed while the phone is in a pocket or bag.

1. With the Treo screen on, press Option  and the Screen  button to enable 
Keyguard.

2. To disable Keyguard, press Center.
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To change your password, 
choose the Password box, 
enter your current 
password, and then enter 
the new password. To 
delete your password, 
choose the Password box, 
and then choose Unassign.
Auto-Keyguard and touchscreen lockout
Auto-Keyguard lets you automatically lock the keyboard after a period of inactivity.

1. Press Applications Launcher . 
2. Choose the pick list in the upper-right corner, and then select All.
3. Choose the Prefs icon. 

4. Choose the pick list in the upper-right corner, and then select Keyguard.

5. Set any of the following preferences:
• Auto-Keyguard: The period of inactivity that passes before the keyboard 

automatically locks.
• Disable touchscreen when: The conditions in which the touchscreen disables. 

Phone Lock
You can lock your phone to prevent unauthorized use of your wireless account. When 
your phone is locked, you must enter the correct Lock Code to make calls. You can, 
however, still place emergency calls when your phone is locked, and you can also 
receive calls. 

1. Press Phone .

2. Press Menu .
3. From the Options menu, choose Phone Lock (/L).
4. Choose one of the following Lock Wireless Mode options:

• On Wireless Mode power off: Locks your phone each time you turn off 
Wireless Mode. When this setting is active, you must enter your lock code each 
time you turn Wireless Mode on again.

•  Immediately: Locks your phone when you choose OK. The next time you turn 
Wireless Mode on you must enter your lock code. After that, you can turn 
Wireless Mode on again without entering your lock code.
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Important: If you lock your 
system, you must enter the 
exact password to unlock 
it. If you forget the 
password, you need to 
perform a hard reset to use 
your phone. Performing a 
hard reset deletes all the 
records in your phone (see 
page 140). However, you 
can restore all previously 
synchronized data at the 
next HotSync operation 
(see page 32).

To lock your system 
manually, choose Lock & 
Turn Off, and then choose 
Off & Lock.
5. When prompted, enter the current Lock Code and choose OK. Unless you changed 
your Lock Code, enter the default Lock code, which is the last four digits of your 
phone number.

6. If you want to change the Lock Code, choose Change Lock Code, enter a new 

Lock Code, and then choose OK to accept it. Repeat this step to verify the new 
Lock Code.

7. Choose Advanced to specify three emergency numbers that you can dial even 
when your phone is locked.

System password lock
You can protect your personal information by locking the system so that a password is 
required to access any data or use other features of your Treo.

1. Press Applications Launcher . 
2. Choose the pick list in the upper-right corner, and then select All.
3. Choose the Security icon. 
4. Choose the Password box.
5. Assign a password and a password hint to your Treo.
6. Choose the Auto Lock Handheld box.
7. When prompted, enter your password.
8. Choose one of the following options:

• Never: Prevents your Treo from locking automatically.
• On power off: Locks your Treo when you turn off the screen, or when it shuts 

off with the auto-off feature.
• At a preset time: Locks your Treo at a specific time of day. 
• After a preset delay: Locks your Treo after a period of inactivity. 
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Setting Owner Preferences
You can use Owner Preferences to record information such as your name, company 
name, and phone number. If you lock your keyboard, the Owner Preferences 
information appears on the screen that requests your password to unlock it, and you 
must also enter your password to change the Owner Preferences information. 

1. Press Applications Launcher . 
2. Choose the pick list in the upper-right corner, and then select All.
3. Choose the Prefs icon. 
4. Choose the pick list in the upper-right corner, and then select Owner. 
5. If you assigned a password with the Security application, choose Unlock, enter your 

password, and then choose OK to continue. 
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As a security measure, 
masked Contacts records 
are temporarily hidden 
when you perform a 
search. So you will not see 
a placeholder for masked 
entries when viewing the 
results of a Lookup or Find 
request.
6. Type the text that you want to appear in the Owner Preferences screen.

Private records
In most applications you can mark individual entries as private. All private entries 
remain visible and accessible until you select the Security setting to hide or mask 
them. When you hide entries, they do not appear anywhere in the application. When 
you mask entries, a visual placeholder appears in place of the entry. If you define a 
password, you must enter it to display private entries. If you do not define a password, 
you (or anyone else) can reveal private entries without a password.
1. Display the entry that you want to mark private. 
2. Choose Details. 
3. Check the Private box.
4. Choose OK.

Hiding or masking all private records
1. Make sure the records you want to mask are marked private. 

2. Press Applications Launcher . 
3. Choose the pick list in the upper-right corner, and then select All.
4. Choose the Security icon. 
5. Choose the Current Privacy pick list, and then select either Hide Records or Mask 

Records.
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Viewing all private records
1. Make sure the records you want to mask are marked private. 
2. Press Applications Launcher . 
3. Choose the pick list in the upper-right corner, and then select All.
4. Choose the Security icon. 
5. Choose the Current Privacy pick list, and then select Show Records.
6. If the Show Private Records dialog appears, enter your password; then choose OK.

Viewing private entries in a specific application
1. Launch the application that contains the private entries you want to display.
2. Press Menu .
3. From the Options menu, choose Security (/H).
4. Choose the Current Privacy pick list, and then select Show Records.
5. Choose OK.

Security and Palm® Desktop (Windows)
Palm Desktop for Windows observes the security password for your Treo. If you forget 
your Treo password, you cannot view your data in Palm Desktop. You can change your 
password, but all records marked as Private will be deleted. You can restore these 
records at the next HotSync operation.

1. Press Applications Launcher . 
2. Choose the pick list in the upper-right corner, and then select All.
3. Choose the Security icon. 
4. Choose the Password box.
5. Choose the Lost Password box.
6. Choose Yes.

If you want additional security for Palm Desktop files, you can purchase a third-party 
solution.
hone and data



if something happens:

help
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Always use the same 
language for your Treo and 
your desktop software. 
Otherwise, you may lose 
data.
Upgrading from a 
Palm Powered™ device

To transfer all compatible applications and data from your previous device to your new 
Treo™ 600 smartphone: 

1. Perform a HotSync® operation with your old device and your old desktop software 
to back up your data one last time. 

2. Install Palm® Desktop software from the CD that came with your Treo (see 
page 31). During the installation process, perform a HotSync operation with your 
new Treo. When prompted to choose a user name for your new Treo, be sure to 
select the existing user name for your old device.

3. Some third-party applications may be quarantined by HotSync Manager because 

they are not compatible with the Palm OS® 5.2 on your Treo. Do not manually 
install any quarantined files (see the documentation that came with the third-party 
applications for more information).

4. If you plan to continue using your old device, perform a hard reset (see page 139) 
to remove its associated user name. Each device you synchronize with your 
computer must have a unique name. The next time you synchronize with your old 
device, be sure to assign it a new user name.

After upgrading, there are a few things you need to know about your new Treo:
• Address Book: This application is now called Contacts. To launch Contacts, press 

Phone , and then use the 5-way navigation control to choose Contacts.
• Date Book+: This application is now called Calendar. To access this application, 

press Calendar .
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To access a menu shortcut, 
press Menu, and then 
press the letter for the 
shortcut.

Some third-party utilities 
allow you to back up your 
old device’s data onto an 
SD™ or MMC™ card, and 
then transfer the data to 
your Treo. We do not 
recommend this method 
because any incompatible 
applications are also 
transferred to your Treo. 
• Applications Launcher: Some previous Palm Powered™ devices called this the 

Home screen. To access this screen, press Applications Launcher .
• Find: Some previous Palm Powered devices launched this global search engine by 

tapping the magnifying glass icon in the Graffiti® area. Now you can access it by 
pressing Option  and Shift  together.

• Menu commands: Users familiar with Graffiti menu commands can now access 

system menus by pressing Menu  (see page 22).
• Backlight: Treo includes a keyboard backlight that also dims the screen slightly for 

low light conditions. While your Treo screen is on, press Option , and then P to 
turn on the keyboard backlight.

• Center button: If you used an earlier model Treo, you might be accustomed to 
pressing Spacebar to activate commands or dial numbers. With this Treo, we 
recommend pressing Center instead.

• Screen button: The fourth button on the right is used to control the screen and is 
not an application button. However, you can remap this button to your favorite 
application (see page 124).

• Internet connection: This Treo was designed to work on high-speed wireless data 
networks. When you sign up for a high speed wireless data account, these settings 
are automatically configured on your Treo.

• 5-way navigation compatibility: Some Palm OS 5 applications are optimized for 
5-way navigation on devices other than Treo. Therefore you may notice 
inconsistencies with software that is not optimized for Treo. 
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Trouble installing Palm Desktop?

The CD included with your Treo installs the software and drivers that let you 
synchronize with Palm Desktop software or Microsoft Outlook for Windows. If you 
want to synchronize with a different Personal Information Manager (PIM), you must 
install a third-party solution. Contact the PIM’s author or vendor to learn if software is 
available for your Treo.
1. Restart your computer.
2. Quit any active applications, including virus scanners and Internet security 

applications.
3. Make sure you’re installing the version of Palm Desktop software that came on the 

CD with your Treo. Other versions of Palm Desktop software may not work with 
this Treo.

4. Make sure your computer profile includes administrator rights to install software. In 
large organizations, these are usually granted by the system administrator. 
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If you need to perform a 
system reset and disable 
conflicting applications, 
always end the process 
with a soft reset. This 
returns your Treo to normal 
operation.
Resetting your Treo

Soft reset
A soft reset is similar to restarting a computer. If your Treo is not responding or you 
have trouble synchronizing with your computer, a soft reset may help. Unless your 
battery is extremely low, a soft reset should not affect your data.
1. Unscrew the stylus tip to access the reset tool.
2. Use the reset tool to gently press the reset button on the back of your Treo.

System reset
A system reset, also called a safe or warm reset, tells your Treo to stop what it’s doing 
and start over again without loading any system extras. If your Treo loops or freezes 
during a soft reset, a system reset may help. Performing a system reset allows you to 
get out of an endless loop so that you can uninstall the third-party application that 
caused the loop. Unless your battery is extremely low, a system reset should not affect 
your data.
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1. Unscrew the stylus tip to access the reset tool.
2. While holding Up , use the reset tool to gently press the reset button on the 

back of your Treo.
3. When the Palm Powered logo appears, release Up .

Hard reset
A hard reset erases all data and third-party software on your Treo. Never perform a 
hard reset without first trying a soft and system reset. You can restore previously 
synchronized data with the next HotSync operation. 

A hard reset can tell you whether a problem is caused by your Treo or an 
application installed on your Treo. If a hard reset eliminates the problem, the problem 
may have been caused by software you installed on your Treo. See page 153 for 
suggestions on diagnosing third-party software issues.
1. Unscrew the stylus tip to access the reset tool.
2. While holding the Wireless Mode button , use the reset tool to gently press the 

reset button on the back of your Treo.
3. When the Palm Powered logo appears, release the Wireless Mode 

button .
4. When the warning appears, press Up  to confirm the hard reset.
5. If a language selection screen appears, choose the same language you selected 

for your desktop software. 
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Screen 

The screen appears blank
1. Look closely at the screen. If you can see a dim image, try adjusting the screen 

contrast and brightness (see page 121). 
2. If adjusting the contrast and brightness doesn’t resolve the problem, perform a soft 

reset (see page 139).
3. If performing a soft reset doesn’t resolve the problem, connect the Treo to the AC 

charger (see page 13) and perform a soft reset again.
4. If another soft reset doesn’t resolve the problem, perform a hard reset (see 

page 140).

The screen doesn’t respond accurately to taps or the wrong 
features are activated

1. Press Applications Launcher . 
2. Choose the pick list in the upper-right corner, and then select All.
3. Choose the Prefs icon. 
4. Choose the pick list in the upper-right corner, and then select Touchscreen. 
5. Follow the onscreen instructions to recalibrate the touchscreen.
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Become familiar with low 
coverage areas where you 
live, commute, work, and 
play. Then, you will know 
when to expect signal 
strength issues.
Network connection

Signal strength is weak
1. If standing, move about 10 feet in any direction.
2. If you are in a building, move near a window. Open any metal blinds.
3. If you are in a building, move outdoors or to a more open area.
4. If you are outdoors, move away from large buildings, trees, or electrical wires.
5. If you are in a vehicle, move your Treo level with a window.

Treo won’t connect to the wireless network
1. Try our suggestions above for weak signals.
2. Turn off Wireless Mode and turn it on again (see page 15).
3. Perform a soft reset (see page 139).

Treo hangs up when I hold it to my ear
You may be accidentally pressing the onscreen Hang Up All button with your cheek. 
Try holding the phone so your face doesn’t press against the screen. If this is not 
convenient, you may want to disable the touchscreen during active calls (see 
page 130).

Treo makes or answers calls when it’s in a briefcase or pocket
Items in your briefcase or pocket may be pressing the onscreen Answer button, or 
otherwise activating screen items. If this happens, you may want to disable the 
touchscreen during incoming calls (see page 130).
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I can’t tell if data services are available 

• The following icons indicate data services:

Wireless Mode is on but you are not connected to any data network.

You are connected to a data network. When the arrows are gray, you 
are in standby mode and you can receive calls. When the arrows are 
green, a data session is active (for example, when you are browsing 
the web) and you cannot receive calls.

Wireless Mode seems to turn off by itself
If a system error and reset occurs, Treo automatically turns on Wireless Mode if it was 
on before the reset. However, if Treo can’t determine whether Wireless Mode was on 
before the reset, it does not turn on automatically and you must manually turn on 
Wireless Mode (see page 15).

Treo won’t connect to the Internet
Your Treo supports high speed (Simple IP) data services. To connect to the Internet, 
you must subscribe to and activate data services with your wireless service provider. 

• Press and hold the Wireless Mode button  to turn off Wireless Mode. Then, 
press and hold the same button to turn it back on again.

• Perform a soft reset (see page 139).
• For additional suggestions, see www.palmOne.com/support.
• Contact your wireless service provider to verify that your subscription plan includes 

high-speed data services and that these services have been correctly activated. 
Your wireless service provider should also be able to tell you if there are any 
outages in your location. Confirm your user name and password.
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• Confirm that high-speed data services are correctly configured on your Treo:

1. Press Applications Launcher .
2. Choose the pick list in the upper-right corner, and then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, and then select Network.
5. If the Service field says Untitled, choose the Service pick list, and then select the 

appropriate data service. Call your wireless service provider for more information 
about their data services.

6. Choose Connect.

I can’t send or receive text messages
• Make sure Wireless Mode is turned on (see page 15).
• Contact your wireless service provider to verify that your plan includes messaging 

services, that these services have been correctly activated, and that they are 
available at your location. (Your wireless service provider should be able to tell you 
if messaging services have been experiencing transmission delays.)

• If possible, contact the recipient or sender of the message, and make sure the 
receiving device can handle the type of file that is being sent.

• If a text message arrives but does not display an alert, perform a soft reset (see 
page 139).
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Every device needs a 
unique name. Never 
synchronize more than one 
device to the same user 
name on your computer.

If you’re using an optional 
serial HotSync cable, click 
the HotSync Manager icon 
on your computer and 
make sure Local Serial is 
checked.
Synchronization (HotSync) 

Synchronization lets you back up your Treo data onto your computer. If you ever need 
to perform a hard reset or otherwise erase all your data on your Treo, you can perform 
a HotSync operation to restore the data. To make sure you always have an up-to-date 
backup of your data, synchronize frequently.

Before you attempt a HotSync operation, make sure that you installed 
Palm Desktop software and HotSync Manager from the CD that came with your Treo.

Desktop does not respond to HotSync attempt
Perform a HotSync operation after each of these steps. If the synchronization is 
successful, you do not need to complete the remaining steps. 
1. Verify that the HotSync cable is securely connected at all points (see page 30).
2. Make sure that HotSync Manager is running:

• Windows: Click the HotSync Manager icon  in the lower-right corner and 
make sure Local USB is checked. If you don’t see the HotSync Manager icon, 
click Start, select Programs, select palmOne and then select HotSync Manager.

• Macintosh: Find the Palm folder on your Mac hard drive. Double-click the 

HotSync Manager icon  in the Palm folder. In the Connection Settings panel, 
set the Local Setup Port to palmOne USB.

3. Verify with your computer hardware vendor that your operating system supports 
your internal USB Controller.

4. Perform a soft reset (see page 139).
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5. If problems persist and you’re synchronizing through a USB hub, try connecting the 
HotSync cable to a different USB port, or directly to your computer’s built-in USB 
port. 

6. Uninstall Palm Desktop.
7. Reboot your computer.
8. Reinstall Palm Desktop.

HotSync operation starts but stops without finishing
Perform a HotSync operation after each of these steps. If the synchronization is 
successful, you do not need to complete the remaining steps. 
1. If you upgraded from a previous Palm Powered device, there may be conflicts with 

files from your previous device. Locate your Backup folder (Windows: C:\Program 
Files\Palm\user name or C:\Program Files\Handspring\user name; Macintosh: 
Mac HD\Applications\Palm\Users\user name or Mac 
HD\Applications\Handspring\Users\user name). Move the Backup folder to 
another location (such as your computer desktop). Perform a HotSync operation, 
and then manually reinstall any third-party applications you want on your new 
phone from the items in the old Backup folder you moved.

2. (Windows only) If the Windows New Hardware Wizard appears, the HotSync 
process may be timing out before the wizard completes its job. Follow all 
instructions in the New Hardware Wizard, and attempt another HotSync operation.

3. Uninstall Palm Desktop.
4. Reboot your computer.
5. Reinstall Palm Desktop.
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The software that lets you 
synchronize with Microsoft 
Outlook is called 
PocketMirror, from 
Chapura, Inc. When you 
install the Treo software 
from the CD, PocketMirror 
will be activated if you 
choose the option to 
synchronize with Outlook.
HotSync operation finishes but data does not appear 
where it should
1. Make sure you’re synchronizing with the intended desktop Personal Information 

Manager (PIM). The CD that came with your Treo lets you synchronize with 
Palm Desktop or Microsoft Outlook for Windows. If you use a different PIM, you 
will need to install third-party software to synchronize. Consult the company that 
makes the PIM for more information.

2. If there are multiple Palm Powered devices synchronizing with your computer, 
make sure you are synchronizing with the correct user name. If data is not 
appearing in Palm Desktop, make sure the correct user name is selected in the 
toolbar of Palm Desktop.

3. Launch the HotSync Manager application on your computer, and make sure the 
necessary conduits are set to Synchronize the files.

4. Uninstall Palm Desktop.
5. Reboot your computer.
6. Reinstall Palm Desktop.
7. (Outlook only) With the included software, your Treo can synchronize with the root 

folders of Contacts, Calendar, Tasks, and Notes. If you want to synchronize with a 
global Exchange Address Book, you must copy the addresses to your local 
Contacts list in Outlook (right-click the addresses, and select Add to Personal 
Address Book). 

8. (Outlook only) Outlook subfolders and public folders are not accessible with the 
included software. You may wish to use a third-party solution instead.

9. (Outlook only) If you’re trying to synchronize offline, be sure to set your Outlook 
Calendar, Contacts, Notes, and Tasks to be available offline.
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If you use web-based email 
(Hotmail, AOL) or corporate 
email (Microsoft Outlook, 
Lotus Notes), the Mail 
application that comes with 
Treo will not work. You 
must use a third-party 
solution. 

Contact your email service 
provider if you are not sure 
whether your email account 
is POP3-compatible.
Mail

I can’t receive email
First, make sure you have Internet access: launch the Blazer web browser to see if 
you can view a web page you’ve successfully viewed before. If necessary, ensure that 

you are viewing the page directly from the Internet: press Menu , and then from 

the Page menu, choose Refresh. The email account you use with the Mail application 
must be a POP3-compatible account, such as Earthlink. 

1. In Mail, press Menu .
2. From the View menu, choose Edit Accounts.
3. Highlight an account, and then choose Edit.
4. Make sure your email address and password are correct.
5. Choose the Server tab.
6. Check the Incoming (POP3) Server and Outgoing (SMTP) Server settings for your 

email account. If you do not have this information, please contact your email 
service provider.

7. Choose OK to accept these settings.
8. Choose Done.

Other things to consider when trying to retrieve email:

• In Mail, press Menu , and then from the Options menu, choose Connection 
Log. This log contains details and error messages from the last several send and 
receive sessions.

• Mail does not automatically retrieve your email when:
• Your radio is off.
• You are outside the automatic delivery time window. See page 80 for more 

information on customizing your mail settings.



When retrieving messages, 
you may see a larger 
number of messages than 
you actually receive (e.g. 
you see Retrieving 1 of 10 
messages and you only 
receive 3 messages). If this 
happens, check your 
Delivery Preferences. If the 
preferences are set to 
retrieve only recent emails, 
any older emails may 
appear in the total number, 
but are not delivered to 
your Treo.
• Some email preferences may not work with your Treo or your wireless network’s 
capabilities. To view these settings, press Menu , and then from the View 
menu, choose Edit Accounts. Choose an account and press Right  to choose 
Edit. Each setting is explained in detail in the Tips for that tab. Contact your email 
service provider to determine the correct settings for your email account.

• Auto-retrieve settings apply to only the mail account you are currently viewing. If 
you have two accounts, Treo auto-retrieves emails for only the current account. To 
change the current account, press Menu , and then from the View menu, 
choose another account.

I can’t open or save an attachment
• You can open only attachments that are supported by the built-in software on your 

Treo or by third-party applications that can open the attachment type. If you can’t 
open an attachment on your Treo, the attachment appears with the paperclip 
icon .

• Large attachments may be truncated, which prevents you from saving them. Scroll 
to the bottom of the email message to see if this is the case. To retrieve the rest of 
the attachment, press Menu , and then from the Message menu, choose Get 
Entire Message. This downloads the remainder of the attachment so that you can 
save it.

I can’t send email
Your ability to send email depends on several factors. You may need to enter 
additional information into the Mail application. Also, some wireless service providers 
use Internet security requirements that may cause difficulties with your email service.
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First, obtain this information from your wireless service provider: 

• Does the Internet connection they provide support sending SMTP emails?
• Is there an alternate SMTP authenticated server used for email?
• Is SSL required for POP3 or SMTP email transactions?

Next, contact your email service provider for this information:
• Does this provider support the POP3 protocol? If they don’t, you won’t be able to 

use Mail for this email account.
• Does this provider allow email access from wireless phone networks?
• What is the user name for your email account?
• What is the outgoing (SMTP) server for your email account? Does it require 

authentication? Does it require SSL? Does it use the same user name for POP3 
and SMTP?

Last, follow these steps:
1. In Mail, press Menu .
2. From the View menu, choose Edit Accounts.
3. Highlight the account you want to edit, and then choose Edit.
4. Make sure your email address and password are correct.
5. Choose the Server tab. Tap the Information icon  for a detailed explanation of 

Server settings.
6. Enter the correct Incoming (POP3) Server setting for your email account. Enter the 

SMTP server used by your wireless service provider for email. 
7. Choose the Advanced tab. Tap the Information icon for a detailed explanation of 

Advanced settings.
8. Check or uncheck the boxes for SSL required for POP3 and SMTP, according to 

the information you received.
9. If necessary, enter your user name. Also enter your email password in the box.
10. Choose OK to accept these settings; then choose Done.



Treo can launch your email 
application when you 
choose an email address 
on a web page. If nothing 
happens when you choose 
the link, try setting up your 
email application first.
Web

I can’t access a page
• Make sure Wireless Mode is turned on (see page 15). 
• Check your Internet access: launch Blazer® and try to view a web page you’ve 

loaded before. Press Menu , and then from the Page menu, choose Refresh to 
get the latest version from the Internet. After confirming your Internet connection, 
try to view the page again, and press Menu , and then from the Page menu, 
choose Refresh.

• If you still have trouble, the page may contain elements that are not supported by 
Blazer. These include Flash, Shockwave, VBScript, WML script, and other plugins.

• Some web sites use a redirector to the true page (for example, the address http://
www.palmOne.com/support may resolve to http://www.palmOne.com/us/support). 
If Blazer can’t follow the redirect, use a browser on your computer to see where the 
redirect sends you, and enter that address in Blazer.

An image or map appears too small on the Treo screen
Blazer has two modes: Optimized and Wide Page. Optimized Mode resizes all images 
and page elements to fit in a single column on the Treo screen. Switch to Wide Page 
mode to see the full-size image (see page 57).

A secure site refuses to permit a transaction
Some web sites don’t support certain browsers for transactions. Please contact the 
site’s webmaster to make sure the site allows transactions using Blazer.
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Pictures

The Pictures application takes pictures at Small picture size (160 x 120 pixels) and 
Large picture size (640 x 480 pixels, or 0.3 megapixel). Here are some tips for taking 
good pictures with the built-in camera:
• Clean the camera’s lens with a soft, lint-free cloth.
• Take pictures in bright lighting conditions. Low-light images may be grainy, due to 

the sensitivity of the camera.
• Hold the camera as still as possible. You may want to support your picture-taking 

arm against your body or a stationary object (such as a wall).
• Keep the subject of the pictures still. Exposure time is longer with lower light levels, 

so you may see a blur.
• For best results, verify that you have the brightest light source coming from behind 

you, lighting the subject’s face. Don’t take indoor pictures with the subject in front 
of a window or light.

• Make sure the subject is at least 18 inches away from the camera to ensure good 
focus.

Remember that when you synchronize, your pictures are stored in the Treo Pictures 
folder on your hard drive (see page 66).

The camera preview image looks strange
Some third-party applications overwrite the Treo’s color settings with their own 8-bit 
color settings. This can affect the camera’s preview mode. Delete third-party 
applications one-by-one until the preview image improves.

When using the camera in low light, you may see blue specks on the screen. Once 
you capture the image, the quality improves, and many of the blue specks disappear.



Third-party applications

Sometimes, third-party applications can cause conflicts on your Treo. Third-party 
applications that modify wireless features may require extra troubleshooting.

If you recently installed an application and your Treo seems to be stuck, try the 
following: 
1. Perform a soft reset (see page 139).
2. If the problem persists, perform a system reset (see page 139). 
3. Delete the most recently installed application from your Treo (see page 109).
4. If the problem persists, perform another system reset.
5. Delete other third-party applications one at a time until you eliminate the problem.
6. If none of the steps above are possible, you may wish to perform a hard reset (see 

page 140). Then, locate your Backup folder on your computer (Windows: 
C:\Program Files\palmOne\user name; Macintosh: Mac 
HD\Applications\palmOne\Users\user name). If you find a .prc or .pdb file for any 
applications you just removed, delete the file(s) from the Backup folder. Then, 
perform a HotSync operation to restore your data and applications.

Remember, not all third-party applications are optimized for the Treo keyboard and 
5-way navigation control. You may encounter strange behavior or errors in these 
applications if you use the keyboard and navigation control.

Getting more help
Contact the author or vendor of any third-party software if you require further 
assistance. 
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Errors

Your Treo is designed to minimize interruptions, when a system error occurs. If Treo 
encounters a system error, it automatically resets itself and resumes functioning as 
normal. If possible, it even turns Wireless Mode back on if it was on before the error 
occurred.

Sometimes you might want to know more about an error. Treo uses a special 
interface to show error messages in greater detail.

1. Press Phone .
2. Press Center, and then choose Dial Pad.
3. Type ##377, and then press Center.
4. Review the screen with details about the conditions that lead up to the most recent 

automatic reset. 
5. Choose OK.

Please note that third-party developers create their own error messages. If you do not 
understand an error message, please contact the developer of the application for help.



Making room on your Treo

If you store a large number of records, or install many third-party applications, the 
internal memory on your Treo may fill up. Here are some common ways to clear space 
on your Treo:
• Mail: Emails that have large attachments can quickly consume memory on your 

Treo. Delete emails with large attachments. If you have hundreds of messages with 
or without attachments, you may want to delete older messages to make room 
(see page 78).

• Pictures: Large-size pictures take up a lot of memory. Move pictures to an 
expansion card or delete pictures from your Treo (see page 64).

• Internet: If you have set a large Blazer cache, you can use Blazer’s advanced 
Memory Management settings to clear all recent pages (see page 61).

• Third-party applications: You can delete infrequently used applications or move 
them to an expansion card (see page 113).

Also, remember that your Treo includes an expansion slot, and that you can store 
applications and data on expansion cards. However, you still need some free memory 
on the Treo itself to run applications from an expansion card.
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Voice quality

Is the other person hearing an echo?
• Try decreasing the Treo’s volume to avoid coupling or feedback on the other 

person’s end. This applies to both speakerphone and the built-in handset speaker.
• Position the Treo handset closer to your ear to prevent sound leaking back to the 

microphone. Keep your hand away from the microphone hole, which is on the back 
of your Treo near the bottom of the device.

• If you’re using Speakerphone mode with the device lying on a flat surface, try 
turning the Treo “face down” (screen facing the surface). 

Are you hearing your own voice echo?
• Ask the other person to turn down their volume or hold the phone closer to their ear.

Is your voice too quiet on the other end?
• Be sure to hold the bottom of the Treo, or the hands-free microphone, close to your 

mouth.



Glossary

Alt (alternative) : A keyboard key. Type a letter on the 
keyboard, and then press Alt  to access variations 
such as international characters and symbols.

Applications Launcher : The view on your Treo™ 600 

smartphone from which you can launch all applications.

Auto-off interval: The time of inactivity that passes before 
the screen on your Treo turns off. Wireless Mode is 
unaffected by this setting.

Beam: The process of sending or receiving a data record 
or application using the infrared port on your Treo. 

HotSync®: The technology that synchronizes your Treo 
and your computer with the simple press of a button.

HotSync Manager: The computer application that 
manages the synchronization with your Treo.

Infrared (IR): A way of transmitting data using light waves. 
The IR port on your Treo lets you transfer data between 
other IR devices within a short radius.

Install tool: The component of Palm® Desktop software 

that enables you to install Palm OS® applications and data 
on your Treo.

Lithium Ion (Li-Ion): The rechargeable battery technology 
used in Treo phones. 

Lock Code: The four-digit password assigned to your 
phone by your wireless service provider. Turning on the 
Lock Code secures your wireless account.

Option key : The keyboard button that lets you access 
the alternative feature that appears above the letter on 
each key.

Palm Desktop: A PIM application for computers that helps 
you manage your personal information and keep your 
personal data synchronized with your Treo.

Palm OS: The operating system of your Treo smartphone. 
Palm OS is known for its simplicity of use and for the large 
number of applications that can be added to your Treo.

Phone : The application on your Treo that provides 

quick access to the most commonly used applications on 
your Treo. 
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PIM (Personal Information Management): A category of 
software that includes applications such as Palm Desktop 
software, Microsoft Outlook, Lotus Notes, and ACT!. PIMs 
generally store contacts, schedules, to do items, and 
memos. 

PocketMirror: Software included on the Treo CD that lets 
you synchronize with Microsoft Outlook (English language 
and Windows only). PocketMirror is made by a third-party 
company called Chapura, Inc.

Simple IP: High-speed mobile data technology that 
enables rapid access to network data services including 
Internet connectivity.

SMS (Short Messaging Service): The service that 
exchanges short text messages almost instantly between 
mobile phones. These messages can usually include up to 

140 characters. Treo phones can send and receive text 

messages while you are on a voice call.

User name: The name associated with your Treo that 
distinguishes it from other Palm Powered™ devices. When 
you first synchronize your Treo, you are asked to give it a 
user name. 

Wireless Mode: The feature inside your Treo that controls 
the radio which enables you to connect to the mobile 
network for wireless communications. 
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FCC Statement   This device complies with part 15 of the FCC rules. 
Operation is subject to the following two conditions: (1) This device may 
not cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause undesired 
operation.

This device has been tested and found to comply with the limits for a 
Class B digital device, pursuant to part 15 of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not 
occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna
• Increase the separation between the equipment and receiver
• Connect the equipment into an outlet or circuit different from that to 

which the receiver is connected
Consult the dealer or an experienced radio/TV technician for help and 

for additional suggestions.

RF Safety Exposure To Radio Frequency Energy (SAR) Radio 
transmitting devices radiate Radio Frequency (RF) energy during its 
operation. RF energy can be absorbed into the human body and 
potentially can cause adverse health effects if excessive levels are 
absorbed. The unit of measurement for human exposure to RF energy is 
“Specific Absorption Rate” (SAR).

The Federal Communications Commission (FCC), Industrie Canada 
(IC), and other agencies around the world have established limits that 
incorporate a substantial safety margin designed to assure the safety of all 
persons using this equipment. 

In order to certify this unit for sale in the US, Canada and Europe this 
unit has been tested for RF exposure compliance at a qualified test 
laboratory and found to comply with the regulations regarding exposure to 
RF Energy.

SAR was measured with the unit transmitting at its maximum certified 
RF power. Often, however, during normal operation the unit will transmit 
much less than maximum power. Transmit power is controlled 
automatically and, in general is reduced as you get closer to a cellular base 
station. This reduction in transmit power will result in a lower RF energy 
exposure and resulting SAR value.

FCC RF Safety Statement In order to comply with FCC RF exposure 
safety guidelines, users MUST use one of the following types of body-
worn accessories. 
1. A palmOne brand body-worn accessory that has been tested for SAR 

compliance and is intended for use with this product.
2. An accessory that contains NO metal (snaps, clips, etc) and provides AT 

LEAST 1 cm of separation between the users body and the unit.
Do NOT use the device in a manner such that it is in direct contact with 
the body (i.e. on the lap or in a breast pocket). Such use will likely 
exceed FCC RF safety exposure limits See www.fcc.gov/oet/rfsafety/ 
for more information on RF exposure safety.

Responsible party
(North America) (Europe)
palmOne, Inc. Vesey Chrichton
400 N. McCarthy Blvd. Buckhurst Court 
Milpitas, CA 95035 London Road
USA Wokingham, Berkshire RG40 1PA,
www.palmOne.com UK

Antenna Care/Unauthorized Modifications Use only the supplied 
integral antenna. Unauthorized antenna modifications or attachments 
could damage the unit and may violate FCC regulations. Any changes or 
modifications not expressly approved by the party responsible for 
compliance could void the user’s authority to operate the equipment.

Potentially Unsafe Areas / Potentially explosive atmospheres Obey all 
signs and instructions regarding turning off your phone. In particular, turn 
off your phone when you are in any areas with a potentially explosive 
atmosphere, such as fueling areas (gas or petrol stations, below deck on 
boats), storage facilities for fuel or chemicals, blasting areas and areas 
near electrical blasting caps, and areas where there are chemicals or 
particles (such as metal powders, grains, and dust) in the air.
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Declaration of Conformity 
Treo Model 600 palmOne declares that the above models of Treo 
smartphones are compliant with the regulations below. The declaration 
applies to the communicators and their associated accessories (power 
supply, headset, USB and serial cable) where applicable.

Maximum Measured SAR Values (W/kg)   

Band: 850 MHz 900 MHz 1800 MHz 1900 MHz 

Head SAR: 1.49 1.07 1.53 1.05 

Body SAR: .646 .703 .402 .336 

EMC: EN 301 489 GSM: EN 301 419-1(Apr 2000)
EN 310 420 (Dec 1999) SAR: ANSI/IEEE C95.1 1992
EN 50360 (July 2001) EN 50361 (July 2001)
FCC OET Bulletin 65 Supplement C Safety: EN 60950: 2000 (Jan-2000)
Radiated Emissions: EN 55022 Immunity: EN 55024

Using TTY 
A TTY (also known as TDD or Text Telephone) is a 
telecommunications device that allows people who are deaf or hard 
of hearing, or who have speech or language disabilities, to 
communicate by telephone.

Your Treo 600 is compatible with select TTY devices. You can 
connect a TTY/TDD machine to your phone through the headset 
jack, but you cannot use your headset jack with a headset or hands-
free kit while this mode is enabled. Please check with the 
manufacturer of your TTY device for connectivity information and to 
ensure that the TTY device supports digital wireless transmission.

To use TTY, you may need to make additional arrangements with 
your wireless service provider. Please contact their customer service 
department for more information.
1. Press Phone.
2. Press Menu.
3. From the Options menu, choose Phone Preferences (/A).
4. Choose the TTY Mode pick list. Then select the appropriate mode.
5. Choose OK. A red “T” appears at the top of the Phone screen 

whenever TTY is enabled.
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Index

Numerics
24-hour clock 127
5-way navigation control. See under 
five

A
AC charger 13
accented characters 25, 26
accessing

applications 27, 28
common tasks 52
Dial Pad 46
web pages 56, 57

activating
application menus 22
keyboard backlight 24
on-screen buttons 22
speakerphone 46
web links 56

active call 46
Active Call view 46, 129
adding

alarms to events 85
bookmarks 57
Caller ID pictures 53, 118
cities to world clock 95
contacts 50
events 84, 86

expansion cards 111, 112
memos 93
passwords 133
personal information 132
QuickText phrases 67
speed dial buttons 53
text messages 67
To Do items 90

additional information and resources 
35, 153
Address Book. See Contacts View
addressing

text messages 67, 71
adjusting

brightness 121
call volume 17, 43, 118
screen contrast 16, 121
system sounds 128

Advanced Calculator mode 96
alarms 85, 117
alert tones 116
alerts

See also alarms
adjusting volume for 128
incoming messages 45, 68
selecting tones for 116
turning off 120
viewing pending 85

aligning the touchscreen 122
alternate characters 25, 26
annual events 86
answering phone calls 43
antenna 10

application buttons and icons 27, 
123
applications

See also specific application
accessing 27, 28
active calls and 47
associating with buttons 54, 

124
beaming 103
categorizing 123
copying 113
installing 107, 108, 124
launching 27, 112, 124
removing 109, 152, 155
setting default 125
troubleshooting third-party 

108, 153
viewing statistics about 110

Applications Launcher 28, 112, 123
appointments. See events
Archive folder 109
area conversions 97
assistance 35
audio files 43
Auto Lock Handheld setting 131
Auto-Keyguard setting 130
Auto-off setting 34, 128

B
backing up data 29, 137, 145
backlight 13, 15, 24, 121
Basic Calculator mode 96
basics 6, 8, 35
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battery
charging 13, 33
consumption factors for 13
maximizing life of 15, 33, 121
resetting handset and 139
viewing status of 14, 39

battery gauge 14
Beam Business Card command 51
Beam Category command 102
Beam command 102, 103
Beam Status dialog box 102, 103
beaming

applications 103
information 102, 104, 128

beeps 128
blank screens 141
blank time slots 88
Blazer web browser 56–62, 155
blue dots 63
Bookmark view 58
bookmarks 57, 58
brightness 121
browsing. See web browsing
buddy lists 50
built-in applications 106, 109
business cards 51, 102
business software 106
buttons

associating with applications 
54, 124

disabling 129
highlighted 21
navigation control 20

restoring defaults for 124
selecting 21, 22
setting preferences for 124

C
calculators 96–98
calendar 84–89
Calendar button 11, 84
calendar views 88
call forwarding 39, 49
Call Log view 42
call waiting 48
Caller ID pictures 53, 63, 118
calls. See phone calls
camera 65, 152, 155
camera lens 12
cancelling selections 23
Caps Lock 25
Card Info application 114
categorizing

applications 123
memos 93

Change Location command 95
changing

bookmarks 58
contact information 51
due dates 92
Favorites buttons 54
lock codes 131
passwords 130
QuickText phrases 67
screen fonts 121
text entries 21

character sets 25, 26
character strings 100
charge indicators 11, 39
charger cable 13
charging the battery 13, 33
chat sessions 69, 70, 71
checking voicemail messages 39
clock 94–95, 126
closing application menus 23
color preferences

system 122, 128
text messages 72

command buttons 22
company searches 100
composing. See creating; entering
compressed files 106
computers

connecting handset to 30
setting up 29–31

conduit software 32
conference calling 48
connections 15, 30, 44, 142
conserving battery power 15, 33, 
121
contact name, dialing by 40
contacts

adding 50
changing information for 51
getting information about 40
locating 99
marking as private 50
removing 51

Contacts View 50
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contrast (screen) 16, 121
conversion functions (calculator) 96
copying

applications 113
phone numbers 41
pictures 65
text 60

copyrighted pictures 64
coverage areas 16, 142
creating

bookmarks 57
business cards 51
Caller ID pictures 53, 118
cities for world clock 95
contacts 50
events 84, 86
memos 93
passwords 133
QuickText phrases 67
speed dial buttons 53
text messages 67
To Do Lists 90

customer assistance 35
customizing

Blazer web browser 61
calendar 87
camera settings 65
passwords 44
phone 116
Pictures settings 65
SMS messaging 71
system colors 122
To Do Lists 89, 92

D
damaged expansion cards 111
data

See also information
backing up 29, 137, 145
expansion cards and 111
keeping private 129
losing 136, 145
restoring 145
storing on handset 33, 111
synchronizing 29, 32, 145–

147
transferring 39, 102

data entry 25
data services 8, 56, 143
dates

See also calendar
assigning to events 84, 86
setting for alarms 85
setting for To Do items 89, 91, 

92
setting system 126
specifying formats for 127

datestamps 71
Day view 84
daylight savings 126
decimal values (calculator) 97
decompression utility 106
definitions 157
delays 131
deleting

applications 109, 152, 155
bookmarks 58

contacts 51
events 86
Favorites button 54
memos 93
passwords 130
pictures 65
text messages 69, 71
To Do items 90, 91

Dial Extra Digits option 53
Dial Pad 41, 42, 46, 118
dialing 16, 40–42, 46

See also phone calls
disabling

handset 129
incoming calls 43

disclaimer 2
discussion groups 35
displaying

application information 110
bookmarks 58
calendar 84, 87, 88
events 88
expansion card information 

114
images 56, 61
pictures 64, 66
private records 134
recently dialed numbers 42
text messages 68
To Do List items 89, 90, 92
web pages 56, 58

documentation 9, 20
Don’t Show Images check box 56
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downloading
files 59
images 59
Palm Desktop software 2

downsizing pictures 64
drawings. See images; pictures

E
echoes 156
Edit Bookmarks command 58
Edit Cities command 95
Edit Favorites Button command 54
Edit Favorites Pages command 54
Edit Name command 65
editing. See changing
email

See also text messages
active calls and 47
attaching items to 75
creating 75
deleting 78
forwarding 77
receiving 76
replying to 77
requirements for 8
sending 68, 151
setting up 73
viewing attachments 77

email applications 68, 151
emergency calls 129, 131
emotive symbols 67
empty battery icon 14
engineering notation 98

entering
information 25
multiple contacts 50
numbers in calculator 96
passwords 45, 53
personal information 132
phone numbers 40, 41
text messages 67

error messages 108
events

creating 84–87
displaying 88
setting preferences for 87, 88

expansion cards
adding 111, 112
beaming to 102
copying to 64, 113
formatting 114
removing applications from 

109
running applications from 112, 

155
viewing information about 114

expansion slot 10, 111
Extra Digits setting 46, 53

F
Favorites buttons 41, 52–54, 118
features (Treo handset) 9
feedback 156
files

decompressing 106
downloading 59

financial calculator 96, 97
Find dialog box 100
Find More button 100
finding

information 99
owner phone number 17
text 61, 100

5-way control buttons 20
5-way navigation control

adding contacts with 50
answering calls from 43
choosing items with 22, 23
dialing with 40
displaying calendar with 84
highlighting items from 21
location of 11
scrolling with 20

fixed point notation 97
floating events 88
fonts 121
forgetting passwords 134
Format Preferences settings 127
formatting expansion cards 114
forwarding phone calls 49
freeing memory 90, 109, 155
full battery icon 14
functions (calculator) 96

G
games 33, 106, 128
General Preferences settings 128
getting started 6, 8, 35
Glossary 157
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graphics. See images
green lightning bolt 14

H
handset. See Treo handset
Hang Up All button 46
hard resets 131, 140, 145
headsets 11, 55
help 35, 153
hexadecimal characters 97
hiding images in web pages 56
hiding private records 133
highlighting 21, 23
hints 35
History list 60
Hold button 46
Home City setting 94
Home Page option 61
HotSync button 124
HotSync cable 29, 30, 145
HotSync connector 11
HotSync Manager 32, 145
HotSync operations 32, 145–147

I
image files 66
images

See also pictures
assigning to Caller ID 53, 118
displaying in web pages 56, 

61
downloading 59

resizing 64
storing 155
troubleshooting 151, 152

importing phone numbers 91
Inbox 69
incoming messages 69
Info screens 110
information

backing up 29, 137, 145
beaming 102, 128
entering 25
finding 99
in reverse type 21
receiving 104
recording personal 132
synchronizing 32, 145–147
transferring to handset 29, 39
updating 32
viewing application 110

Information icon 35
Infrared port. See IR port
installing

applications 107, 108, 124
Palm OS software 106, 138
synchronization software 29, 

31
international characters 26
Internet connections 15
invalid characters 67
IR port

beaming from 102, 103, 104
location of 10

J
JPEG files 66

K
keyboard

dialing with 40
locking 129
overview 24–25

keyboard backlight 13, 15, 24, 121
Keyboard Help command 25
keyboard shortcuts 22
keyguard feature 16, 129

L
launching applications 27, 112, 124
LED indicator 11, 13, 33
length conversions 97
lens (camera) 12
liability 2
listening to music 55
lists

cancelling selections in 23
choosing items in 22
highlighting items on 21
moving through 20
selecting options in 23

loading web pages 56, 61
locating

information 99
owner phone number 17
text 61, 100

Location icon 50
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lock codes 131
lock icon 56, 103, 109
Lock Wireless Mode options 130
locked messages 69
locking the handset 129, 130, 131
logic functions (calculator) 97
losing data 136, 145
low coverage areas 142
lowercase letters 25

M
Macintosh information

installing applications 108
installing synchronization 

software 29
removing applications 109
synchronizing data 145

magnet 12
Mail application 73–81
manually activating backlight 15
manually setting clock 126
maps 151
masking private records 133
mathematical constants 97
mathematical functions 96
maximizing battery life 15, 33, 121
media players 33
Memo Pad 93
memory 90, 109, 112, 155
memory slots (calculator) 97
memos 93

See also messages; notes
Menu button 22

menus 22
messages

See also text messages
checking voicemail 39
retrieving voicemail 39, 45
reverse type in 21
sending to voicemail 43
setting alerts for 117

messaging services 8
metric conversions 97
microphone 11, 46, 55, 156
Microsoft Outlook. See Outlook
Microsoft Windows See Windows 
information
MMC cards 111
MMS messaging 8
mobile accounts 35
mobile phone. See Treo handset
monthly events 86
moving through

menu items 22
web pages 56, 57, 60

MultiMedia cards 111
multiple recipients 67
music 43, 55
Mute button 46

N
Name Lookup feature 40, 99
navigation buttons 20
navigation control. See 5-way 
navigation control
network status icon 16

networks 142
New Contact button 50
New Text Message screen 68
nighttime use 15
No Service message 16
Note Pad. See Memo Pad
notes 50, 67, 91

See also memos; messages
notifications 45, 68
numbers 25, 96, 98

O
offline viewing (web pages) 58
online forums 35
online support 35
opening

Blazer web browser 56
Dial Pad 46
Find dialog box 100
Phone application 38

Optimized Mode (web pages) 56
optimizing performance 30, 33
Option Lock 25
options 23, 88

See also preferences
organizer features 33, 83
Outbox 69
outgoing messages 69
Outlook 29, 84, 138, 147
owner preferences 132
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P
Page View icon 56
paging through web pages 56
paging tool 20
Palm Desktop software 2, 29
Palm OS features 15, 28, 106, 138
Palm Powered devices 147
partial battery icon 14
passwords

changing 44, 130
creating 133
entering 45, 53
forgetting 134
specifying as required 131

PCs. See computers
pending alerts 85
performance 30, 33
personal computers. See computers
Personal Information Managers 
(PIMs) 138, 147
phone (disabled) 13
Phone application

accessing 38
creating business cards with 

51
managing calls from 46
managing contacts from 50
monitoring information for 39

Phone button 11, 38
phone calls

adjusting volume for 17, 118
battery consumption and 13
defining ringtones for 53, 116

disabling incoming 43
displaying most recent 42
forwarding 49
losing 43
making duplicate 47
options for dialing 40, 46
placing on hold 46, 47, 48
prerequisites for 16
receiving 43
sending to voicemail 43
setting preferences for 116
setting up emergency 131
turning off ringer for 120

phone headsets 55
Phone Info option 17
Phone Lock command 130
phone numbers

adding speed dial buttons for 
53

adding to To Do List 91
dialing extensions for 46, 53
dialing from text messages 42, 

68
entering 40, 41
getting 17
labeling mobile 50
pasting to Dial Pad 41
redialing 42
specifying emergency 131

Phone Preferences command 49
phone receiver 11
phone settings 116
photographs. See pictures; images

pick lists 21, 23
Pictures 63, 65
pictures

See also images
adding Caller ID 53, 118
downsizing 64
managing 64
saving 63, 65
sending 64
setting size 65
taking with camera 63
viewing 64, 66

Pictures view icon 64
playing

music 55
PocketMirror software 147
power status 14
power supply connector 11
preferences

Blazer web browser 61–62
calendar 87
camera 65
owner 132
phone calls 116
Pictures 65
SMS messaging 71
system colors 122
To Do List 89, 92

preset delays 131
priority settings 69, 89, 91, 92
privacy settings 68, 91, 133
private records 133–134
protecting data 129
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punctuation characters 25, 26
Purge command 69, 90

Q
Quick Keys 52, 54
QuickText phrases 67

R
receiving

information 104
phone calls 43
text messages 68

recharging handset 33, 39
recording voice messages 44
recurring events 86
red lightning bolt 14
redialing 42
refreshing web pages 56
Reminder screen 85
reminders 68, 85

See also alerts
remote cities 95
removing

applications 109, 152, 155
bookmarks 58
contacts 51
events 86
expansion cards 111
Favorites button 54
memos 93
passwords 130
pictures 65

text messages 69, 71
To Do items 90, 91

renaming
expansion cards 114
pictures 65

repeating events 86
rescheduling events 86
Reset button 12
reset tool 12, 139
resets 131, 139–140, 145
resizing images 64
restoring

data 145
factory defaults 124
private records 134

reverse type 21
ringer 10, 43, 116, 120
Ringtone option 53
ringtones

phone calls 53, 116
selecting for caller ID 118
text messages 68
turning off 120

roaming 39

S
saving

pictures 63, 65
web pages 58

scheduling events 84, 86
scientific calculator 96
scientific notation 97
screen

adjusting contrast 16, 121
aligning 122
auto shutoff setting for 128
blue dots on 63
disabling 46, 128, 129
highlighting items on 21
moving around in 20
tapping Information icon on 35
troubleshooting 141
turning on and off 15, 34

Screen button 11
screen fonts 121
scroll arrows 21
scroll bars 21
scrolling 20
SD cards 65, 111

See also expansion cards
searching

information 99–101, 133
web pages 61

Secure Digital cards. See SD cards
secure web pages 56, 151
security software 129, 134
Select Business Card command 51
Select Home City command 94
sending

email 68, 151
text messages 67, 69, 70

Sent folders 69
serial cables 29
short messaging. See SMS 
messaging; text messages
shortcuts 22, 52, 137
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Show Due Dates option 92
signal strength 13, 39, 142
signals 34
silencing the ringer 43, 116, 120
silent alarms 85, 120
sit files 106
SMS button 11
SMS messaging 54, 67, 70, 71
Snooze option 68
soft resets 139
software 9, 29, 31, 138

See also applications
Sort by Date command 69
Sort by Name command 69
sorting

text messages 69
To Do List items 92

Sound Mode Off option 43
sounds 43, 120, 128

See also alarms; music; 
ringtones

Sounds icon 117
speaker 12
speakerphone 13, 46, 156
special characters 25, 26
specifications 55, 111, 173
speed dial button 53
Spkr-phone button 46
stand by 39
starting

applications 112
Blazer web browser 56
built-in tutorial 35

statistical functions (calculator) 97
status icons (text messages) 69
stereo adapters 55
storing

data 33, 111
Treo handset 12

stylus 10, 16, 21, 22, 23
support 35
symbols 25, 26, 67
synchronization software 9, 29, 31
synchronizing data 29, 32, 145–147
system resets 139
system sounds 43, 120, 128

T
taking pictures 63
tasks. See To Do List
technical support 35
temperature conversions 97
text

See also messages; notes
copying 60
finding on web pages 61, 100
in reverse type 21
selecting 21

text fields 21, 22
text messages

addressing 67, 71
creating 67
deleting 69, 71
dialing from 42, 68
receiving 68
sending 67, 69, 70

setting preferences for 71
sorting 69
troubleshooting 144
viewing status of 69

text selection tools 21
third-party applications 106, 108, 
124, 153, 155
third-party software 20, 32
three-way calling 48
time 94, 95, 126
time formats 127
time slots (events) 84, 88
time zones 126
timestamps 71
tips 35
To Do List

checking off items 91
creating 90
displaying items in 89, 90, 92
prioritizing items in 90, 92
removing items 90, 91
setting preferences for 89, 92

touchscreen. See screen
transferring data 39, 102
Treo handset

additional references for 56
aligning screen for 122
caution for storing 12
charging 13, 33, 39
components shipped 9
connecting to PCs 30
extending storage capacity 

111
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features 9
freeing space on 109, 155
locking 129, 130, 131
resetting 131, 139–140, 145
setting up 16
storing data on 33
transferring information to 29, 

39
troubleshooting 153, 156
turning on and off 15
tutorial for 35
viewing power status for 14

trigonometric functions 97
troubleshooting 138, 153, 156
TTY icon 39
turning down volume 17
turning handset on and off 15
turning on keyboard backlight 15, 
24, 121
turning on Wireless Mode 15
turning screen on and off 15, 34
Tutorial 35
Typing Starts Contacts Search 
preference 40

U
unauthorized users 129
unlocking keyguard 16
unlocking the handset 130
unread messages 69
untimed events 85, 86
updating information 32
upgrades 29, 109, 136, 146

uppercase letters 25
urgent messages 69
URLs 68
USB hubs 30
USB ports 30
user discussion groups 35

V
viewing

application information 110
bookmarks 58
calendar 84, 87, 88
events 88
expansion card information 

114
images 56, 61
pictures 64, 66
private records 134
recently dialed numbers 42
text messages 68
To Do List items 89, 90, 92
web pages 56, 58

voice messages 44
voicemail

checking messages for 39
retrieving messages 39, 45
sending messages to 43
setting up 44

Voicemail Favorites button 44
voicemail icon 45
voicemail services 43, 44
volume buttons 11, 17, 116, 118
volume conversions 97

VP icon 50

W
wallpaper 63, 118, 119
warranty 111
web browsing

customizing 61
overview 56
requirements for 5, 8
troubleshooting 143, 151

web links 21, 54, 56, 68
web pages

adding bookmarks for 57
clearing cache for 155
copying from 60
dialing from 42
disabling images on 61
displaying 56, 58
navigating through 56, 57, 60
opening from text messages 

68
refreshing 56
removing bookmarks for 58
reverse type in 21
saving 58
searching 61
setting Favorites buttons for 

54
viewing history lists for 60
viewing offline 58

weekly events 86
weight conversions 97
Wide Page Mode command 57
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Windows information
installing applications 106, 

107
installing synchronization 

software 29
removing applications 109
synchronizing data 145, 146, 

147
viewing pictures 66

wireless accounts 35
wireless connections 15
wireless coverage areas 16, 34, 142
wireless features 15, 33
Wireless Mode 15, 39, 143
Wireless Mode button 10
world clock 94–95

Z
zip files 106
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Specifications
Radio CDMA 1900/800 digital dual-band

1XRTT; also supports CSD

Phone features Personal speakerphone
Hands-free headset jack (2.5 mm, 3-pin barrel connector)

Microphone mute option
TTY compatible 
3-way calling

Processor Technology 144 MHz Texas Instruments OMAP (ARM) processor

Expansion SD™/MMC™ slot (SD I/O compatible)

Battery Rechargeable Lithium Ion
Up to 3 hours full charge time

Up to 4 hours talk time
Up to 10 days standby time

Palm OS® version Palm OS 5.2.x

Camera VGA resolution (640x480), 0.3 megapixel Automatic light balance

Size 4.41 in x 2.36 in x .87 in (11.2 cm x 6.0 cm x 2.2 cm) without antenna

Weight 6.2 ounces (175 grams)

IR Yes

Display LCD CSTN Touchscreen (includes stylus)
3375 colors 

(11.5-bit color, compatible with 16-bit applications)

User-adjustable brightness and contrast

Keyboard Built-in QWERTY keyboard plus 5-way navigation control
Backlight for low lighting conditions

Included software Phone (including Palm OS Contacts, Favorites, Dial Pad)
Pictures
Blazer® Web Browser (Internet)
Mail
Memo Pad
PocketMirror Standard (for synchronizing with Microsoft 

Outlook for Windows)

Calendar (Palm OS Date Book+)
SMS (text messaging)
To Do List
Calculator (basic and advanced)
Palm® Desktop and HotSync® Manager
CityTime world clock

System requirements Windows 98SE, Me, 2000, or XP with USB port. Windows NT4 
requires serial cable, sold separately

Mac OS 10.1-10.3.x with USB port
Later versions may also be supported

Operating and storage 
temperature range

0C-40C
5% to 90% RH 
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